
IBM Cognos Business Intelligence Series 7
IBM Cognos Series 7 Version 5

Version 7.5

Installation Testing and Samples Setup Guide



Product Information
This document applies to IBM Cognos Series 7 Version 5 and may also apply to subsequent releases. To check for newer versions of this document,
visit the IBM Cognos Information Centers (http://publib.boulder.ibm.com/infocenter/cogic/v1r0m0/index.jsp).

Copyright
Licensed Materials - Property of IBM
© Copyright IBM Corp. 1999, 2010.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
IBM, the IBM logo, ibm.com, and Cognos are trademarks or registered trademarks of International Business Machines Corp., in many jurisdictions
worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on
the Web at www.ibm.com/legal/copytrade.shtml.
Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in
the United States, and/or other countries.
Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
UNIX is a registered trademark of The Open Group in the United States and other countries.
Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

http://publib.boulder.ibm.com/infocenter/cogic/v1r0m0/index.jsp


Table of Contents

Introduction 7
IBM Cognos Samples 7

Additional Materials 9

Chapter 1: Setting Up Samples 11
Preparing Samples for UNIX 11
Create Sample Data Sources 11

Generate Sample Databases Using Oracle 12
Generate Sample Databases Using Sybase 13
Generate Sample Databases Using DB2 15
Ensure the DB2 Server and Client are Synchronized 17

Add Data Sources to the Default Namespace 18
Connect an Impromptu Catalog to the Databases for Impromptu Web Reports 19

Create Database Definitions 19
Verify Tables in the Sample Catalog 21

Chapter 2: Testing PowerPlay User 23
Open a Sample Report 23

Chapter 3: Testing Impromptu 25
Test Impromptu Administrator 25
Test Impromptu User 26
Add Data Source for PowerPrompts (UNIX Samples) 26

Add the Data Source to the Target Namespace 27
Create the Signon 28
Apply the Signon to a User 28
Troubleshooting PowerPrompts 28

Chapter 4: Testing PowerPlay Transformer 29
Test PowerPlay Transformer on UNIX 29
Test PowerPlay Transformer on Windows 29

Chapter 5: Testing IBM Cognos OLAP 33
Test PowerPlay Enterprise Server 33
Test the Connection Between PowerPlay for Windows and the PowerPlay Enterprise Server 35
Test Transformer 35
Test the Windows Launch Agent 36

Chapter 6: Testing IBM Cognos Reporting 39
Prepare for Testing 39

Add Data Sources to the Target Namespace (Windows) 39
Add a Creator User Class 41
Create a Samples User Profile 41

Test IBM Cognos Reporting 41
Test Impromptu Web Reports - Server Administration 42

Licensed Materials – Property of IBM
3© Copyright IBM Corp. 1999, 2010.



Test Impromptu Web Reports - Report Administration 42
Test Impromptu Administrator 44

Chapter 7: Testing IBM Cognos Visualizer 45
Open a Sample Visualization 45

Chapter 8: Testing IBM Cognos Visualizer Web 47
Prepare to Test IBM Cognos Visualizer Web 47

Set Security Properties 47
Provide Link to the IBM Cognos Visualizer Web Client Installation 48
Add a Visualization to the Server 48

Test IBM Cognos Visualizer Web 49
Open a Visualization from the Table of Contents 49
Open a Visualization from Upfront 50

Chapter 9: Troubleshooting 51
Troubleshooting Resources 51

Configuration Manager 52
Access Manager - Administration 52
Windows Event Viewer 52
Log Files 52

General Problems 53
Configuration Values Not Applied 53
Services Not Running 53
Port Numbers Do Not Match 53
Failure to Change Default Values 53
Lack of Connectivity Between Components 53
Multiple Versions of the Server Configuration File 54
Web Protocol for Relative URL Support 54
ISO 8859-15 Encoding 54
Mounting IBM Cognos CDs Using the Rock Ridge Method 54
Microsoft Internet Explorer Blocks Active Content 55

Cannot Log On 55
Access Manager Server Ticket Service is Not Configured or Not Available 55
Unable to Log On Error Message 56
Unable to Log On Using OS Signons and Microsoft IIS Server 58

Cannot Find a Component or Information 58
Cannot Find Samples Folder or Files 58
Unable to Find a PDF Report 58
Do Not Know What Directory Server Ports are Being Used 59
Data Store Does Not Exist 59
Cannot Find Server Configuration (cer .csx) File 60

Cannot Open a Component or Information 61
PowerPlay Server Not Available 61
Cannot Open Model When Publishing to Upfront 62
No Access to Database 63
Unable to Open Server Model Due to Incorrect or Missing DataSource Path 64

Cannot Connect to a Component 64
Cannot Load Apache Module into Server When Using ReportNet and Impromptu Web

Reports on the Same Web Server 64

4 IBM Cognos Series 7 Version 5

Table of Contents



Unable to Connect to Upfront Server 65
Cannot Connect to Servers, Nothing is Responding, and Similar Observations After Installing

on UNIX 66
Configuration Manager Apply Error with Access Manager - Runtime 67

Cannot Start or Stop a Component 67
Unable to Open Requested Application When Starting Upfront 67
OLE Initialization Failed 67
PowerPlay Enterprise Server Not Available 68
Unable to Start Upfront 68
Unable to Start Access Manager Server 69
Request to Run PowerPlay Enterprise Server Failed 69
Unable to Start Transformer 69
Access Manager Server Ticket Service Not Configured or Not Available When Using

Impromptu Web Reports 70
Unsatisfied Link Error When Starting NoticeCast Dispatcher on AIX 70
NoticeCast Data Store Does Not Start When Connecting to a Data Store Within an SQL

Server Database 71
Unable to Start NoticeCast Server on UNIX 71
NoticeCast Server Fails to Start 71
NoticeCast Server Does Not Start After Installation of Another IBM Cognos Product 72
Host Refused Connection Starting Configuration Manager on UNIX 72
NoticeCast Data Store Does Not Start Automatically on Windows 2000 Computers 72

Cannot Create, Publish, or Display Information 74
Cannot Open a File 74
Unable to Publish to Upfront 75
Message Tunnel Failure While Publishing Report Set 75
Multi-Page Report Does Not Display Properly 76
Special Characters in Report Titles Not Displayed Properly When PowerPlay Web Report

Exported to Microsoft Excel 76
PDF Report Opens in New Window 76
Unable to Publish Reports to Another Computer 77
Report Elements Not Active 78
Unable to View Impromptu Web Reports 78
Database Create Error 78
Problems Publishing from PowerPlay Enterprise Server Administration 79
No Response When Requesting a Report Using a Web Browser 80
Unable to Use ObjectStore as an Impromptu Web Reports Data Store When Installed on

a Different Computer 80
Data Source Cannot be Accessed, Error with NoticeCast Save 80
Sample PowerPrompts Fail on UNIX 81
ObjectStore Error Using Impromptu Web Reports on UNIX 83
Database Create Error with Impromptu Web Reports 84
Database Not Created or Cannot Be Accessed Error with Impromptu Web Reports 84
Cannot Run PowerPrompts Samples with UNIX Sample Database 85
PowerPrompts Samples Do Not Work with Sybase Sample Database 85
Upfront Icons Not Displaying Correctly 87

Other Authentication Problems 87
Starting Upfront Server Administration Returns an Authentication or Access Privileges

Error 87

Installation Testing and Samples Setup Guide 5

Table of Contents



Access Denied Message Trying to Connect to PowerPlay Enterprise Server After Changing
the LDAP Server/Namespace 87

Repeated Requests to Log On 87
General Runtime or Installation Problems 88

File Transfer Fails in UNIX 88
Access Manager Server Ticket Service Not Responding 88
Asian Fonts Do Not Display Correctly in PowerPlay 88
PowerPlay Request Failures 89
Multiple Request Managers Running on Server 89
Apply Failure When Installing and Configuring Sun Java System Directory Server from the

IBM Cognos Install Menu 90
Runtime Parameters Not Saved in Environment Script File 90
Sun Java System Directory Server Availability Problems 90
Display Problems When Using AIX with Exceed 91
Cannot Execute Commands in the Documentation or Commands Are Not Working as

Expected (UNIX) 91
Error Message When Configuring Microsoft Active Directory 91
Menu Shortcuts (Alt+key) Do Not Work in Administration Program (UNIX) 91
Problem Identifying the Namespace When Logging into Upfront 92
Cannot Establish Connection to NoticeCast Data Store 92
JDBC Driver Not Included in Class Path After Default Configuration 94
Alerts Button on PowerPlay Web Toolbar is Disabled 94
UNIX File Transfer May Not Function Properly 94
Display Problems When Using HPTerm on UNIX 95
Configuration Manager Cannot Write Properties to Registry in Windows 2000 95
Failure Transferring or Installing a File in UNIX 96
Unable to Run the Setup Program issetup on UNIX Installation - Permission Denied 96
ObjectStore Server is Unavailable or Not Configured Properly 96
Errors Using the DataDirect ODBC Driver Manager on UNIX with Locale Other Than

en_US 98
Characters Do Not Display Correctly in Email on Mobile Devices 98
Cannot Configure the Directory Server for Series 7 Via a Secured Port 99

Index 101

6 IBM Cognos Series 7 Version 5

Table of Contents



Introduction

This document is available as an online book and, for some IBM Cognos product installations, as

a printed one as well. For information about related documents, see "Additional Materials" (p. 9).

IBM Cognos Samples
The product tutorials use IBM Cognos sample files to demonstrate product features. For some

products, the samples must be set up before you can use them.

Installation Testing and Sample Setup Guide

This guide contains instructions for testing your product installation and setting up the necessary

samples.

Note: Some Asian languages are not supported by IBM Cognos Impromptu, IBM Cognos Impromptu

Web Reports, and IBM Cognos Visualizer.

Finding Information

To find the most current product documentation, including all translated documentation, access

one of the IBM Cognos Information Centers at http://publib.boulder.ibm.com/infocenter/cogic/

v1r0m0/index.jsp.

You can also read PDF versions of the product release notes and installation guides directly from

IBM Cognos product disks.

Samples Disclaimer

The Great Outdoors Company, GO Sales, any variation of the Great Outdoors name, and Planning

Sample, depict fictitious business operations with sample data used to develop sample applications

for IBM and IBM customers. These fictitious records include sample data for sales transactions,

product distribution, finance, and human resources. Any resemblance to actual names, addresses,

contact numbers, or transaction values, is coincidental. Unauthorized duplication is prohibited.
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Additional Materials

Depending on the IBM Cognos products you installed, you may consult related documents at the

following locations.

LocationTopic

installation guidesHow to install IBM Cognos products

printed book and online book (PDF)

Discovering TransformerLearn how to use PowerPlay Transformer

online book (PDF)

Discovering PowerPlayLearn how to use PowerPlay

online book (PDF)

Discovering ImpromptuLearn how to use Impromptu

online book (PDF)

IBM Cognos Visualizer TutorialLearn how to use IBM Cognos Visualizer

online book (PDF) and Windows help

Discovering DecisionStreamLearn how to use DecisionStream

online book (PDF)

Note: For more information about creating sample databases on UNIX using Oracle, IBM DB2,

or Sybase, see the IBM Cognos Resource Center

Formats

Our documentation includes user guides, tutorial guides, reference books, and other materials to

meet the needs of our varied audience.

Online Help

All information is available in online help. Online help is available from the Help button in a Web

browser, or the Help menu and Help button in Windows products. All online help is also available

from the Windows Start menu (Start, Programs, rendition_name, Documentation).

Books for Printing

The information in each online help system is available in online book format (PDF). However, the

information from a given help system may be divided into more than one online book. Use online

books when you want to print a document or when you want to search the whole document.

Licensed Materials – Property of IBM
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You can print selected pages, a section, or the whole book. The company grants you a non-exclusive,

non-transferable license to use, copy, and reproduce the copyright materials, in printed or electronic

format, solely for the purpose of providing internal training on, operating, and maintaining the

IBM Cognos software.

You can also read the product readme files and the installation guides directly from IBM Cognos

product CDs.
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Chapter 1: Setting Up Samples

This document includes procedures to help you test your installation. By performing these procedures,

you also set up the IBM Cognos samples used by the product tutorials to demonstrate product

features.

If you installed one of the IBM Cognos query or reporting components for UNIX, you must prepare

the samples for UNIX before you can perform the installation testing procedures and set up samples.

For more information, see "Preparing Samples for UNIX" (p. 11).

If you do not plan to use samples, you can use your own data to test the installation. If you use

your own data, then file names, paths, and output will be different than described in the testing

procedures. We recommend that you test your installation, even if you do not need to set up samples.

To test your installation, perform the procedures in the testing chapter for your product.

If you use the auditing feature in Impromptu Web Reports, you can use the sample audit catalog

and reports to get started. For more information, see the Impromptu Web Reports Administration

Guide.

Preparing Samples for UNIX
If you installed one of the IBM Cognos query or reporting components for UNIX, you must prepare

the samples for UNIX before you can perform the installation testing procedures and set up samples.

The procedures in this section assume that you have already configured an authentication source,

added a connection to your directory server, and set up the runtime credentials. If you followed the

installation procedures in the installation guide, you have already performed these tasks.

To prepare samples for UNIX, you must

❑ create sample data sources by running SQL scripts using supported versions of Oracle, IBM

DB2, or Sybase

❑ add the data sources to the default namespace

❑ connect an Impromptu catalog to the sample database (UNIX reporting components only)

After you have prepared the samples for UNIX, you can test your installation and set up samples.

After you have prepared the samples for UNIX, you can test your installation and set up samples.

Create Sample Data Sources
To create sample data sources, you run SQL scripts the currently supported versions of Oracle,

IBM DB2, or Sybase.

After you have created the sample data sources using the appropriate SQL script, proceed to "Add

Data Sources to the Default Namespace" (p. 18).

Licensed Materials – Property of IBM
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Generate Sample Databases Using Oracle
The following steps for generating sample databases apply to Oracle.

Steps

1. Ensure that the SQL scripts for creating sample data sources are installed in the installation_

location/samples/db directory.

If the directory exists and contains gosales, gosalesdw, govendors, and marketresearch, then

the samples are installed.

If the samples are not installed, perform a custom installation to install them.

2. Create an Oracle user account named gosales. Grant the user account create table privileges,

the Connect role and the Resource role.

3. Create the ORACLE_HOME environment variable by typing the following:

ORACLE_HOME=Oracle_installation_location

4. Create the TNS_ADMIN environment variable.

The following is an example of the command to create this variable:

TNS_ADMIN=/home/scripts/

5. Create the PATH environment variable.

The following is an example of the command to create this variable:

PATH=$ORACLE_Home/bin:$PATH

6. Export the environment variables you created.

The following is an example of the command to export the variables:

export ORACLE_HOME TNS_ADMIN PATH

7. Use a SQL login tool to run the following SQL scripts:

● GOSALES.sql

● GOVENDORS.sql

● GOMARKET.sql

● GOSALESDW.sql

8. Ensure that the Oracle server information in the tnsnames.ora file is the same on your Windows

computer and your UNIX computer.

The following is an example of the Oracle server information in the tnsnames.ora file:

ORASMPL8.WORLD =

(DESCRIPTION =

(ADDRESS = (PROTOCOL = TCP)(HOST =
server_name
)(PORT = 1521))

(CONNECT_DATA = (SID = ORASMPL8))
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Generate Sample Databases Using Sybase
The procedures for generating sample databases that apply to Sybase include

● transferring the files and creating databases

● creating environment variables

● running SQL scripts

Steps to Transfer the Files and Create Databases

1. Ensure that the SQL scripts for creating sample data sources are installed on your computer.

To verify whether the scripts are installed, go to the installation_location/samples/db directory.

If the directory exists and contains gosales, gosalesdw, govendors, and marketresearch, then

the samples are installed.

If the samples are not installed, perform a custom installation to install them.

2. Create a Sybase database for each of the four sample data sources. Name the databases gosales,

govendors, gomarket, and gosalesdw.

Each database requires 10 MB of space. The databases will not expand.

3. Create a user for each database and grant each new user access to the corresponding database,

with create table privileges. Name the new users gosales, govendors, gomarket, and gosalesdw.

Note: Optionally, you can create a single user and grant the user access to all four of the data-

bases.

4. If you installed Impromptu Web Reports for UNIX, you can test your installation by publishing

samples contained in the installation_location/samples/iwr_unix/reports directory.

Steps to Create Environment Variables

1. Create the SYBASE environment variable by typing the following:

SYBASE=Sybase_location

2. Create the SYBASE_ASE environment variable.

The following is an example of the command to create this variable:

SYBASE_ASE=ASE-12_0

3. Create the SYBASE_OCS environment variable.

The following is an example of the command to create this variable:

SYBASE_OCS=OCS-12_0

4. Create the SYBASE_FTS environment variable.

The following is an example of the command to create this variable:

SYBASE_FTS=FTS-12_0

Installation Testing and Samples Setup Guide 13
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5. Create the PATH environment variable.

The following is an example of the command to create this variable:

PATH=Sybase_location/$SYBASE_OCS/bin:$SYBASE/$SYBASE_ASE/bin:$SYBASE/

$SYBASE_FTS/bin:$PATH

6. Add the Sybase library location to an existing library search path, or create a new library search

path variable.

To add the Sybase libraries location to an existing library search path variable, type the

appropriate command for your environment.

● For Solaris, type:

LD_LIBRARY_PATH=Sybase_location/$SYBASE_ASE/lib:$SYBASE/$SYBASE_OCS/

lib:$LD_LIBRARY_PATH ; export LD_LIBRARY_PATH

● For HP-UX, type:

SHLIB_PATH=Sybase_location/$SYBASE_ASE/lib:$SYBASE/$SYBASE_OCS/lib:$SHLIB_

PATH ; export SHLIB_PATH

● For IBM AIX, type:

LIBPATH=Sybase_location/$SYBASE_ASE/lib:$SYBASE/$SYBASE_OCS/lib:$LIBPATH

; export LIBPATH

If the library search path variable does not already exist, create it by typing the appropriate

command for your environment.

● For Solaris, type:

LD_LIBRARY_PATH=Sybase_location/$SYBASE_ASE/lib:$SYBASE/$SYBASE_OCS/lib

; export LD_LIBRARY_PATH

● For HP-UX, type:

SHLIB_PATH=Sybase_location/$SYBASE_ASE/lib:$SYBASE/$SYBASE_OCS/lib ; export

SHLIB_PATH

● For AIX, type:

LIBPATH=Sybase_location/$SYBASE_ASE/lib:$SYBASE/$SYBASE_OCS/lib ; export

LIBPATH

7. Create the DSQUERY environment variable.

The following is an example of the command to create this variable:

DSQUERY=SASSOL12

8. Export the environment variables you created.

The following is an example of the command to export the variables:
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export SYBASE SYBASE_ASE SYBASE_OCS SYBASE_FTS DSQUERY PATH TERM

Steps to Run the SQL Scripts

1. Ensure that the connection parameters in each executable match your environment settings.

The following is an example of the connection string contained within the scripts:

isql -Uusername -Puserpassword -Sservername -Ddatabasename -i drop.sql -o drop.log

Modify the scripts so that servername is the name of the server where your Sybase database is

located.

Note: For some versions of Sybase, you may receive a syntax error similar to the following.

Syntax Error in '-Ddatabasename'

To correct the error, change -D to -d (lowercase).

If you did not use the recommended user names, user passwords, and database names when

you created the databases, you must modify each of the scripts to reflect the correct values.

Replace username with the correct username for the database. Replace userpassword with the

correct user password, and replace databasename with the name of the database.

2. Run the following batch files:

● gosales.bat

● govendors.bat

● gomarket.bat

● gosalesdw.bat

3. Ensure that the server information in the SQL.ini file on your Windows computer matches the

server information in the interfaces file on your UNIX computer.

The following is an example of server information from the SQL.ini file:

[SASSOL12]

master=TCP,server_name,4115

query=TCP,server_name,4115

The following is an example of server information from the interfaces file:

SASSOL12

master tcp ether server_name 4115

query tcp ether server_name 4115

Generate Sample Databases Using DB2
The procedures for generating sample databases that apply to DB2 include

● transferring the files and creating databases

● creating environment variables

● running SQL scripts

Installation Testing and Samples Setup Guide 15
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● ensuring the DB2 server and client are synchronized

Steps to Transfer the Files and Create Databases

1. Ensure that the SQL scripts for creating sample data sources are installed on your computer.

To verify whether the scripts are installed, go to the installation_location/samples/db directory.

If the directory exists and contains gosales, gosalesdw, govendors, and marketresearch, then

the samples are installed.

If the samples are not installed, perform a custom installation to install them.

2. Create a database for each of the four sample data sources. Name the databases gosales,

govendor, gomarket, and gosalesdw.

Each database requires 10 MB of space. The databases will not expand.

3. Create a user for each database and grant each new user access to the corresponding database,

with create table privileges. Name the new users gosales, govendors, gomarket, and gosalesdw.

Note: Optionally, you can create a single user and grant the user access to all four of the data-

bases.

Ensure that your user account has permissions for each of the four databases.

4. If you installed Impromptu Web Reports for UNIX, you can test your installation by publishing

samples contained in the installation_location/samples/iwr_unix/reports directory.

Steps to Create Environment Variables

1. Create the DB2DIR environment variable by typing the following:

DB2DIR=DB2_location

2. Create the DB2INSTANCE environment variable.

The following is an example of the command to create the DB2INSTANCE variable:

DB2INSTANCE= db2fis72

3. Create the PATH environment variable.

The following is an example of the command to create this variable:

PATH=$DB2DIR/bin

4. Create the INSTHOME environment variable.

The following is an example of the command to create this variable:

INSTHOME=/disk1/home/db2fis72

5. Add the DB2 library location to an existing library search path, or create a new library search

path variable.

To add the DB2 library location to an existing library search path variable, type the appropriate

command for your environment.

● For Solaris, type:
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LD_LIBRARY_PATH=DB2_location/lib:$LD_LIBRARY_PATH ; export

LD_LIBRARY_PATH

● For HP-UX, type:

SHLIB_PATH=DB2_location/lib:$SHLIB_PATH ; export SHLIB_PATH

● For IBM AIX, type:

LIBPATH=DB2_location/lib:$LIBPATH ; export LIBPATH

If the library search path variable does not already exist, create it by typing the appropriate

command for your environment.

● For Solaris, type:

LD_LIBRARY_PATH=DB2_location/lib ; export LD_LIBRARY_PATH

● For HP-UX, type:

SHLIB_PATH=DB2_location/lib ; export SHLIB_PATH

● For AIX, type:

LIBPATH=DB2_location/lib ; export LIBPATH

6. Export the environment variables you created.

The following is an example of the command to export the variables:

export DB2DIR DB2INSTANCE PATH INSTHOME

Steps to Run the SQL Scripts

1. If you did not use the recommended database names when you created the databases, modify

the connect.sql file so that it contains the correct database names.

2. Run the following batch files:

● gosales.bat

● govendors.bat

● gomarket.bat

● gosalesdw.bat

Ensure the DB2 Server and Client are Synchronized
The DB2 server and DB2 client must be synchronized, meaning that they are both upgraded to the

same fixpac level. To ensure that the server and client are synchronized, verify the fixpac level of

your DB2 server and then apply the same fixpac to your DB2 client.

Alternatively, you can use bind commands to synchronize the server and client.

Steps to Synchronize the DB2 Server and Client Using Bind Commands

1. In the DB2 utility, connect to the target database as a user with database administrator privileges.

Installation Testing and Samples Setup Guide 17
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2. Go to the bnd directory.

The following is an example of the path to the bnd directory for a computer named fisher:

/fisher/home/db2fis61/sqllib/bnd

The following is an example of the path to the bnd directory for a computer named fisher:

/fisher/home/db2fis61/sqllib/bnd

3. Type the following commands:

bind @db2ubind.lst BLOCKING ALL SQLERROR CONTINUE GRANT PUBLIC

bind @db2cli.lst BLOCKING ALL SQLERROR CONTINUE GRANT PUBLIC

Add Data Sources to the Default Namespace
Any data source that you use for your reports or queries must be added to the default namespace

in Access Manager. You must add each of the four databases that you created to the default

namespace.

Steps

1. From the Start menu, click Programs, IBM Cognos Series 7 Version 4, IBM Cognos Server

Administration.

2. Click Security.

If you have not created and saved a connection to a directory server, see the installation guide

for your product.

3. In the left pane, expand Directory Servers and the directory server name.

4. Double-click the namespace you are using, typically default.

5. If the IBMCognos Common Logon dialog box appears, type the default user ID Administrator,

leave the password box blank, and click Log On.

6. Click the Data Sources folder and from the Action menu, click Add Database.

The Database Properties dialog box appears.

7. On the General tab, in the Name box, type GOSALES

8. Select the This Database Requires a Signon check box.

9. Click the Connection tab.

10. In the Database Type box, click the database type for the program you used to create the

databases (for example, Oracle).

11. Click Edit.

The Database Definition dialog box appears.
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12. Perform the steps that correspond to the database software you used to generate the sample

databases on UNIX.

For Oracle:

● In the Logical database name box, type the logical name for the database. For example,

for the GOSALES database, type GOSALES

● In the SQL *Net connect string box, type the service name or database alias, as defined by

the database administrator.

● In the Gateway type box, click None. Proceed to Step 13.

For Sybase:

● In the Logical database name box, type the logical name for the database. For example,

for the GOSALES database, type GOSALES

● In the SQL server name box, click the server where your Sybase database is located. Proceed

to Step 13.

For DB2:

● In the Logical database name box, type the logical name for the database. For example,

for the GOSALES database, type GOSALES

● In the DB2 database name box, type the name of the database. For example, for the

GOSALES database, type GOSALES

● In the DB2 connect string box, type the service name or database alias, as defined by the

database administrator.

13. Click OK to close the property sheet.

14. Repeat steps 6 to 13 to add the GOVENDORS, MARKETRESEARCH, and GOSALESDW

databases.

Connect an Impromptu Catalog to the Databases for Impromptu
Web Reports

To connect an Impromptu catalog to the sample database, you must create database definitions

and verify that the tables in the sample catalog correspond to those in the sample databases.

Create Database Definitions
Repeat the following steps for each of the four IBM Cognos sample databases.

Steps

1. From the Startmenu, click Programs, IBMCognos Series 7 Version 4, IBMCognos Impromptu

Administrator.

2. From the Catalog menu, click Databases.
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The Database Definition Manager appears.

3. From the list of Database Drivers in the Database gateways and drivers list, click the appropriate

driver for the database software you used to create the sample databases (for example, Oracle).

4. Click New Database.

The Database Definition dialog box appears.

5. Perform the steps that correspond to the database software you used to generate the sample

databases on UNIX.

For Oracle:

● In the Logical database name box, type the logical name for the database. For example,

for the GOSALES database, type GOSALES

● In the SQL *Net connect string box, type the service name or database alias, as defined by

the database administrator.

● In the Gateway type box, click None. Proceed to Step 6.

For Sybase:

● In the Logical database name box, type the logical name for the database. For example,

for the GOSALES database, type GOSALES

● In the SQL server name box, click the server where your Sybase database is located. Proceed

to Step 6.

For DB2:

● In the Logical database name box, type the logical name for the database. For example,

for the GOSALES database, type GOSALES

● In the DB2database name box, type the name of the database. For example, for the GOS-

ALES database, type GOSALES

● In the DB2 connect string box, type the service name or database alias, as defined by the

database administrator.

6. To verify that Impromptu can connect to the remote database, click Test.

7. Type the database login and password, and then click OK.

If Impromptu cannot connect to the database, a dialog box appears describing the error. Fix

the error.

8. Repeat steps 1 to 7 for the GOVENDORS, GOSALESDW, and MARKETRESEARCH databases.
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Verify Tables in the Sample Catalog
Before you can use the sample GOSales catalog to access the data stored in the sample databases,

ensure that the catalog contains the most up-to-date information. You must verify that the tables

in the sample catalog exist in the sample databases.

Steps

1. From the Startmenu, click Programs, IBMCognos Series 7 Version 4, IBMCognos Impromptu

Administrator.

2. From the Catalog menu, click Open.

3. Go to the installation_location/samples/iwr_unix/reports directory.

4. Click GOSales.cat and click Open.

If the IBM Cognos Common Logon: default window appears, type your user ID and password

for IBM Cognos products and click Log On.

5. In the Catalog logon for GOSALES.CAT dialog box, click Creator in the User class box, clear

the Connect to database check box, and click OK.

6. From the Catalog menu, click Tables.

The Tables dialog box appears.

7. From the Database drop-down list, click the logical name of the GOSALES database (for

example, GOSALES).

The Catalog logon for GOSALES.CAT dialog box appears.

8. In the User ID and Password boxes, type the database signon created by the database adminis-

trator for the database.

9. In the Database tables dialog box, double-click GOSALES. Then click Rename.

The Rename Catalog Component window appears.

10. Type the database name that the database administrator created that stores the samples schema,

and click OK.

The name that you type must match one of the names that appears in the Database tables dialog

box.

11. From the Catalog tables list, click the top level of the database hierarchy, and click Verify.

None of the tables should be labelled with a red X.

12. To close the Tables dialog box, click OK.

Proceed to "Testing IBM Cognos Reporting" (p. 39) to test your IBM Cognos Reporting

installation and set up the samples.
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Chapter 2: Testing PowerPlay User

You can perform the tests in this section to ensure that PowerPlay User is installed correctly.

The test procedures assume that you used the installation guide to perform a default installation.

If you performed a custom installation, you may not have installed all the components required to

perform the tests.

The test procedures assume that you are using IBM Cognos sample data to test your installation.

If you use your own data, then file names, paths, and output will be different than described in the

test procedures.

The test procedures assume that you used the example values for user IDs, passwords, and install-

ation locations. If you used different values, you must replace the values in the test procedures with

your values.

If you encounter problems while performing the test procedures in this section, see the

troubleshooting chapter for information about fixing common installation and configuration

problems.

To test your PowerPlay User installation, open a sample report.

Open a Sample Report
The following steps describe how to open a sample report to test your PowerPlay User installation.

Steps

1. From the Startmenu, click Programs, IBM Cognos Series 7 Version 4 (or the option for your

installed version of the product), and IBM Cognos PowerPlay.

2. Click Open an existing report.

3. Clear the Prompt for Cube check box.

4. Go to the installation_location\samples\PowerPlay\Cubes and Reports directory.

5. Click Percentage Sales.ppr, and then click Open.

The report opens.

6. Close PowerPlay.
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Chapter 3: Testing Impromptu

You can perform the tests in this section to ensure that Impromptu is installed correctly. By perform-

ing the tests, you verify that the components are configured to interact properly.

The test procedures assume that you used the installation guide to perform a default installation.

If you performed a custom installation, you may not have installed all the components required to

perform the tests.

The test procedures assume that you are using IBM Cognos sample data to test your installation.

If you use your own data, then file names, paths, and output will be different than described in the

test procedures.

The test procedures assume that you used the example values for user IDs, passwords, and install-

ation locations. If you used different values, you must replace the values in the test procedures with

your values.

If you encounter problems while performing the test procedures in this section, see

"Troubleshooting" (p. 51) for information about fixing common installation and configuration

problems.

To test your Impromptu installation, open a sample catalog with Impromptu Administrator and

open a sample report with Impromptu User.

You can also test the PowerPrompts samples installed with Impromptu (Windows) by navigating

to the installation_location\samples\powerprompts directory, opening any of the .xxm files in

Development Studio, making and then testing your changes.

If you only installed Impromptu Web Reports and the IWR samples, you need to copy the

PowerPrompts .xxm files to the appropriate location, either samples/iwr/reports or samples/iwr_

unix/reports. Set up the sample reports to use the appropriate PowerPrompts application on the

Administrative tab of the Report Properties sheet, then run them in Upfront.

If you plan to use the sample dynamos and PowerPrompts with IBM Cognos samples that are on

a UNIX computer, you must first add the data source for PowerPrompts. For more information,

see "Add Data Source for PowerPrompts (UNIX Samples)" (p. 26).

Test Impromptu Administrator
To test the installation of Impromptu Administrator, open a sample catalog.

Steps

1. From the Startmenu, click Programs, IBMCognos Series 7 Version 4, IBMCognos Impromptu

Administrator.

2. If the Welcome dialog box appears, click Close.

3. From the Catalog menu, click Open.
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TheOpen Catalog dialog box shows the default location where the sample catalogs are installed:

installation_location\samples\Impromptu\reports

4. Click gosales.cat and then click Open.

5. If the IBMCognos Common Logon dialog box appears, type the default user ID Administrator,

leave the password box blank, and click Log On.

The Catalog Logon dialog box for the Gosales catalog appears.

6. In the User Class box, click Creator and then click OK.

The catalog opens.

7. On the Catalog menu, click Folders to view the list of folders in the catalog. You can expand

a folder to view the columns it contains.

8. Click Cancel and then close Impromptu Administrator.

Test Impromptu User
To ensure that Impromptu User is installed properly, open a sample report.

Steps

1. From the Start menu, click Programs, IBMCognos Series 7 Version 4, IBMCognos Impromptu.

The Welcome dialog box appears.

2. Click Open an Existing Report.

The Open dialog box appears.

3. Click currency.imr and then click Open.

By default, currency.imr is installed in installation_location\samples\Impromptu\Reports.

4. If the IBMCognos Common Logon dialog box appears, type the default user ID Administrator,

leave the password box blank, and then click Log On.

The Catalog Logon dialog box appears.

5. From the User Class list, click User Class Administration, leave the Password box blank, and

click OK.

You use this initial user class to log on to the Gosales catalog provided with Impromptu samples.

6. When the currency report opens in Impromptu, ensure that you can see the data.

Add Data Source for PowerPrompts (UNIX Samples)
The data source used for the dynamos and recordsets for PowerPrompts samples point to a logical

database name named GOS. For the samples to work correctly when connecting to a UNIX database,
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you must add the GOS data source to Access Manager, create a signon for the data source, and

apply the signon to a user.

This procedure is for UNIX installations only. If you performed a Windows installation, proceed

to "Add Data Sources to the Target Namespace (Windows)" (p. 39).

Add the Data Source to the Target Namespace
The following steps describe how to add the GOS data source to Access Manager.

Steps

1. Open Access Manager - Administration.

2. Connect to the directory server and expand the target namespace.

3. If the IBMCognos Common Logon dialog box appears, type the default user ID Administrator,

leave the password box blank, and click Log On.

4. Expand Data Sources.

5. If the Data Sources folder contains a data source named GOS, delete the GOS data source.

6. Right-click Data Sources and then click Add Database.

7. In the Database Properties dialog box, type GOS in the Name box.

8. Click the Connection tab.

9. In the Database Type box, select the appropriate database and then click Edit.

10. Specify the server where the UNIX sample databases are installed.

● For Oracle, type the server name in the SQL *Net connect string box.

● For Sybase, select the server from the SQL server name box.

● For DB2, type the server name in the DB2 database name box.

11. Click Test.

The Attach to Database dialog box appears.

12. Type a valid user ID and password to access the database and click OK.

A message tells you that the database attached successfully.

13. Click OK.

14. In the Database Definition dialog box, click OK.

15. In the Database Properties dialog box, click OK.

16. Complete the steps to create a signon.
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Create the Signon
After adding the GOS data source to Access Manager, create a signon for it.

Steps

1. In the Authentication Information window, expand the GOS data source folder.

2. Right-click Signons and then click Add Database Signon.

3. In the User ID box, type a valid user name.

4. In the Password and Verify Password boxes, type a valid password and then click OK.

5. Complete the steps to apply the signon to a user.

Apply the Signon to a User
After creating a signon for the GOS data source, apply the signon to a user.

Steps

1. Expand the Users folder in the namespace hierarchy.

2. Right-click a user and click Properties.

The User Properties dialog box appears.

3. Click the Memberships tab.

4. Select the Root User Class check box.

The user must have root user access privileges.

5. In the User Properties dialog box, click the Access tab.

Select the GOS datasource check box, and then click OK.

Troubleshooting PowerPrompts
If you have completed the preceding steps for UNIX, and are still having problems testing your

PowerPrompts installation, consult the following troubleshooting topics, for further guidance:

● "Sample PowerPrompts Fail on UNIX" (p. 81)

● "Cannot Run PowerPrompts Samples with UNIX Sample Database" (p. 85)

● "PowerPrompts Samples Do Not Work with Sybase Sample Database" (p. 85)
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Chapter 4: Testing PowerPlay Transformer

You can perform the tests in this section to ensure that your edition of PowerPlay Transformer is

installed correctly. By performing the tests, you verify that the components are configured to

interact properly.

The test procedures assume that you used the installation guide to perform a default installation.

If you performed a custom installation, you may not have installed all the components required to

perform the tests. If you performed a distributed installation, some components are installed on

other computers. To perform the test procedures in a distributed environment, you may need to

specify network paths to components that are installed on other computers.

The test procedures assume that you are using IBM Cognos sample data to test your installation.

If you use your own data, then file names, paths, and output will be different than described in the

test procedures.

The test procedures assume that you used the example values for user IDs, passwords, and install-

ation locations. If you used different values, you must replace the values in the test procedures with

your values.

If you encounter problems while performing the test procedures in this section, see the

troubleshooting chapter for information about fixing common installation and configuration

problems.

Test PowerPlay Transformer on UNIX
To test a UNIX installation, use PowerPlay Transformer to create or update a cube, and then open

the cube using PowerPlay. You must use your own data for this test. Sample data is not provided.

Steps

1. On your UNIX computer, use PowerPlay Transformer for UNIX to create or update a cube.

For information about how to create a cube, see the Transformer for UNIX documentation.

2. From your UNIX computer, use binary FTP mode to move the cube to your Windows computer.

3. On your Windows computer, from the Startmenu, click Programs, IBMCognos Series 7 Version

4 (or your currently installed version of the product), and IBM Cognos PowerPlay.

4. Locate and click the cube you created, and click Open.

Test PowerPlay Transformer on Windows
The following procedures test the integration of components in PowerPlay Transformer (Windows

editions).

To test a Windows installation, you
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● set the GOsecurity.lae file as your default authentication source

● use Transformer to open a model (with a regular data source)

Steps to Set the Authentication Source (Sample LAE File)

1. Open Configuration Manager (accessible from the Start menu, Tools option, for your IBM

Cognos product version).

2. From the File menu, click Open Current Configuration.

3. In the Explorer window (left pane), expand the Services component, expand Access Manager

- Runtime, and then click Authentication Source.

4. In the Authentication Source - Properties window (right pane), click the Value box and select

LAE from the drop-down list, to make it your default authentication source.

5. In the Explorer window (left pane), under Authentication Source, click LAE.

6. In the LAE - Properties window (right pane), click the Value box for the File property, click

the ellipsis, locate and select the GOSecurity.lae file, and click Open.

Tip: The default location for this sample LAE file is installation_location\samples\accman.

7. Click the Value box for the Default Namespace property to make it editable, and type

GOnamespace as your namespace.

Note: You can revert to your default Directory Server configuration at any time, using a similar

set of steps. Just make sure that the Computer property contains the correct location of your

directory server, especially if you are configuring a remote directory server.

8. In the Explorer window, right-click Access Manager - Runtime and click Apply Selection.

9. Click Yes to confirm, and OK to acknowledge the information message.

10. Close Configuration Manager.

The GOsecurity.lae file is now your default authentication source.

Steps to Open a Model

1. Open PowerPlay Transformer (accessible from the Start menu, Tools option, for your IBM

Cognos product version).

2. From the File menu, click Open.

3. Go to to the installation_location\samples\PowerPlay\Cubes and Reports directory, click

Outdoors.mdl.

4. If the IBM Cognos Common Logon dialog box appears, logon as user ID Administrator with

no password, or user ID asmith with no password. Click Log On.

5. In the User Class dialog box, select Creator from the list, and click OK.

Note: Even if no access controls are placed on a cube, the namespace is used to connect to the

data source. If prompted about updating the user class hierarchy, click Yes to open the sample
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model. Later, if you decide to use a directory server or an LAE file other than GOsecurity as

your authentication source, remember to first use Configuration Manager to change your

default authentication source; see "Steps to Set the Authentication Source (Sample LAE

File)" (p. 30).
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Chapter 5: Testing IBM Cognos OLAP

You can perform the tests in this section to ensure that IBM Cognos OLAP is installed correctly.

By performing the tests, you verify that the components are configured to interact properly.

The test procedures assume that you used the installation guide to perform a default installation.

If you performed a custom installation, you may not have installed all the components required to

perform the tests. If you performed a distributed installation, some components are installed on

other computers. To perform the test procedures in a distributed environment, you may need to

specify network paths to components that are installed on other computers.

The test procedures assume that you are using IBM Cognos sample data to test your installation.

If you use your own data, then file names, paths, and output will be different than described in the

test procedures.

The test procedures assume that you used the example values for user IDs, passwords, and install-

ation locations. If you used different values, you must replace the values in the test procedures with

your values.

If you encounter problems while performing the test procedures in this section, see

"Troubleshooting" (p. 51) for information about fixing common installation and configuration

problems.

To test IBM Cognos OLAP, you test

● PowerPlay Enterprise Server by opening a sample cube with your Web browser, publishing a

sample cube to Upfront, and viewing it in Upfront

● the connection between PowerPlay Enterprise Server and PowerPlay for Windows by starting

PowerPlay and opening a remote cube on the PowerPlay Enterprise Server

● Transformer by opening a sample model

● the Windows Launch Agent by using PowerPlay for Windows to view a report that has been

published to Upfront

Test PowerPlay Enterprise Server
To test your installation of PowerPlay Enterprise Server, publish a sample cube to Upfront, and

then view it in Upfront using your Web browser.

If you did not install Upfront, you can test your installation by opening a sample cube using your

Web browser.

Steps

1. Start PowerPlay Enterprise - Server Administration.
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● On Windows, from the Start menu, click Programs, IBM Cognos Series 7 Version 4, IBM

Cognos Server Administration. When the IBM Cognos Server Administration window

opens, click OLAP Cubes and Reports.

● On UNIX, from a UNIX emulator terminal, go to the directory where PowerPlay Enterprise

Server is installed. Change to the installation_location/bin directory. Type ./ppsrvadm.sh
to start the administration tool.

The Connect to Server dialog box appears.

2. Ensure that the Server name is the name of the computer where PowerPlay Enterprise Server

is installed, and click OK.

3. If the PowerPlay Enterprise - Server Administration dialog box informs you that the server is

not secured, click Yes.

4. If the IBMCognos Common Logon dialog box appears, type the default user ID Administrator,

leave the password box blank, and click Log On.

5. If the Set Security dialog box appears, click OK.

The Item list shows sample cubes and reports.

6. Do one of the following:

● If Upfront is installed, in the Item list, click Great Outdoors, and then from the Tools menu,

click Publish to the Portal (Upfront).

A message appears stating that the cube was successfully published. Click OK.

● If Upfront is not installed or not yet configured, in the Item list, click Great Outdoors, and

then from the Tools menu, click Open with browser.

The cube opens in your Web browser.

7. Close PowerPlay Enterprise - Server Administration.

8. Open a Web browser and type the following URL to access Upfront:

http://server_name/cognos

If you didn't use the default Web alias values, replace cognos with the appropriate alias value.

9. If the IBMCognos AccessManager Logon page appears, type the default user IDAdministrator,

leave the password box blank, and click Log On.

10. In the NewsIndex, click Great Outdoors.

The Great Outdoors sample cube opens. You have successfully published a sample cube to

Upfront.

11. Close your Web browser.
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Test the Connection Between PowerPlay for Windows and the
PowerPlay Enterprise Server

To test the connection between PowerPlay for Windows and the PowerPlay Enterprise Server, start

PowerPlay for Windows and open a remote cube on the PowerPlay Enterprise Server.

Steps

1. From the Start menu, click Programs, IBMCognos Series 7 Version 4, IBMCognos PowerPlay.

2. Click Open an existing report.

The Choose a Report dialog box appears.

3. In the Files of type box, click PowerPlay Cubes (*.mdc).

4. In the Access box, click Remote.

The Choose a Remote Cube dialog box appears.

5. Beside the Connection box, click Connections.

The Connections dialog box appears.

6. Click Add.

7. In the Connection box, type a name for the connection.

8. In the Server box, type the name of the computer where PowerPlay Enterprise Server is installed,

and then click OK.

In a distributed environment, use the name of the computer where the PowerPlay Enterprise

Server Dispatcher is running. If you are not using the default port, append the port number.

9. In the Connections dialog box, click OK.

10. In the Choose a Remote Cube dialog box, click Sample Cube, and then click Open.

PowerPlay opens the sample cube.

11. Close PowerPlay. If prompted to save changes, click No.

Test Transformer
To test Transformer, open a sample model.

Steps

1. From the Start menu, click Programs, IBM Cognos Series 7 Version 4, Tools, PowerPlay

Transformer.

2. From the File menu, click Open.

The Open dialog box appears.

3. Go to the installation_location\samples\PowerPlay\Cubes and Reports directory.
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4. Click GO Market Research.mdl, and then click Open.

The GO Market Research model opens.

5. Close PowerPlay Transformer.

Test the Windows Launch Agent
The Windows Launch Agent enables you to use PowerPlay to access reports that were previously

published to Upfront.

This test will work only if Windows Launch Agent is installed with PowerPlay Enterprise Server.

If you performed a default installation of IBM Cognos OLAP on the server, then the Windows

Launch Agent is installed.

To test the Windows Launch Agent, you

● publish a report to Upfront

● open the report in Upfront and change the run options to run it in Windows.

The Windows Launch Agent opens the report in PowerPlay on your computer.

Steps to Publish a Report

1. From the Start menu, click Programs, IBM Cognos Series 7 Version 4, IBM Cognos Server

Administration.

2. Click OLAP Cubes and Reports.

The Connect to Server dialog box appears.

3. Ensure that the Server name is the name of the computer where PowerPlay Enterprise Server

is installed, and then click OK.

4. If the IBMCognos Common Logon dialog box appears, type the default user ID Administrator,

leave the password box blank, and click Log On.

5. On the Item list, click Print Settings.

6. From the Tools menu, click Open with Browser.

The browser opens and the Modify Report page appears.

7. At the bottom of the Modify Report page, click OK.

8. On the toolbar at the bottom right of the page, click the Save As button.

9. If the IBMCognos AccessManager Logon page appears, type the default user IDAdministrator,

leave the password box blank, and click Log On.

10. At the bottom right of the Save As page, click Other NewsBox.

The Select a NewsBox page appears.

11. Click NewsIndex, and then click OK.
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12. Click OK again.

PowerPlay Enterprise Server publishes the sample report to the NewsIndex.

13. Close your Web browser.

14. Close PowerPlay Enterprise - Server Administration.

Steps to Open a Report and Change the Run Options

1. Open a Web browser and type the following URL to access Upfront:

http://server_name/cognos

If you did not use the default Web alias values, replace cognos with the appropriate alias value.

2. If the IBMCognos AccessManager Logon page appears, type the default user IDAdministrator,

leave the password box blank, and click Log On.

Observe that the NewsIndex contains the Print Settings report, which you published in the

previous procedure.

3. Under the Print Settings report, click Actions.

4. Under Run report in Web Viewer with saved prompts, click Other run options.

5. Click Run report in Windows, and click OK.

6. If you do not have Microsoft Virtual Machine installed on your computer, you will be

prompted to install and run it.

Microsoft Virtual Machine is created by Microsoft and distributed with your IBM Cognos

software.

The sample report opens in PowerPlay.

7. Close PowerPlay and your Web browser.

8. If you are prompted to save as an Upfront NewsItem, click OK.
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Chapter 6: Testing IBM Cognos Reporting

You can perform the tests in this section to ensure that IBM Cognos Reporting is installed correctly.

By performing the tests, you verify that the components are configured to interact properly.

The test procedures assume that you used the installation guide to perform a default installation.

If you performed a custom installation, you may not have installed all the components required to

perform the tests. If you performed a distributed installation, some components are installed on

other computers. To perform the test procedures in a distributed environment, you may need to

specify network paths to components that are installed on other computers.

The test procedures assume that you are using IBM Cognos sample data to test your installation.

If you use your own data, then file names, paths, and output will be different than described in the

test procedures.

The test procedures assume that you used the example values for user IDs, passwords, and install-

ation locations. If you used different values, you must replace the values in the test procedures with

your values.

If you performed a UNIX installation, you must follow the procedures in "Preparing Samples for

UNIX" (p. 11) before you perform the procedures in this section.

If you encounter problems while performing the test procedures in this section, see

"Troubleshooting" (p. 51) for information about fixing common installation and configuration

problems.

Prepare for Testing
To prepare for testing the installation, you

● add data sources to the target namespace (Windows only)

● add a data source for PowerPrompts (UNIX samples only)

● add a Creator user class

● create a samples user profile

Add Data Sources to the Target Namespace (Windows)
To use the sample data, you must add the sample data sources to the target namespace. If you

performed a default installation, the target directory server is your computer, and the target

namespace is default.

This procedure is for Windows installations only. If you performed a UNIX installation, proceed

to "Add Data Source for PowerPrompts (UNIX Samples)" (p. 26).
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You begin by defining the data sources in the target namespace.

Steps

1. Open Access Manager - Administration.

2. In the Authentication Information list, expand Directory Servers.

3. If there are no directory servers listed, you can open the .csa file that you created when you

followed the installation guide steps for testing your installation. From the File menu, click

Open. Go to the .csa file that you created, and then click Open. Expand Directory Servers.

If you did not create a .csa file, you must add a connection to your directory server. For more

information about how to add a connection, see the installation guide or the Access Manager

Administration Guide.

4. Expand the target directory server.

5. Expand the target namespace.

6. If you are prompted to log on to the target namespace, enter a user ID and password, and then

click Log On.

The default User ID is Administrator, with no password.

7. Right-click Data Sources, and then click Add Database.

The Database Properties dialog box appears.

8. On the General tab, in the Name box, type the logical database name, Market Research, and

then clear the This database requires a signon check box.

9. On the Connection tab, from the Database Type list, click ODBC, and then click Edit.

The Database Definition - ODBC dialog box appears.

10. In the ODBC Data Source list, click GOMRcern.

11. Clear the User ID and Password check boxes.

12. Click Test to test the connection.

13. In the Database Definition - ODBC dialog box, click OK.

14. In the Database Properties dialog box, click OK.

15. Repeat steps 7 to 14 to add the following data sources:

ODBC Data Source

instead of GOMRcern

Logical Database Name

instead of Market Research

GOScernGO Sales

GOVcernGO Vendors
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ODBC Data Source

instead of GOMRcern

Logical Database Name

instead of Market Research

GODWcernGO Sales DW

16. Leave Access Manager open for the next procedure.

Add a Creator User Class
After adding a data source, add a Creator user class.

Steps

1. In the target namespace, right-click Root User Class and then click Add User Class.

The User Class Properties dialog appears.

2. In the Name box, type Creator, and click OK.

3. Leave Access Manager - Administration open for the next procedure.

Create a Samples User Profile
After adding a Creator user class, create a samples user profile.

Steps

1. In the target namespace, right-click Users, and then click Add User.

The User Properties dialog box appears.

2. On the General tab, in the Name box, type samples

3. On the User Signons tab, select the Basic Signon check box.

4. In the User ID box, type samples

5. In the Password and Verify Password boxes, type samples

6. On the Access tab, select the Market Research, GO Sales, GO Vendors, and GO Sales DW
check boxes.

7. On the Memberships tab, select the Root User Class and Creator check boxes.

8. On the Upfront tab, clear the Allow Personal NewsBox check box, and click OK.

9. Close Access Manager - Administration.

Test IBM Cognos Reporting
Before you can test IBM Cognos Reporting, you must perform the procedures in "Prepare for

Testing" (p. 39).
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To test the IBM Cognos Reporting installation, you test

● Impromptu Web Reports - Server Administration

● Impromptu Web Reports - Report Administration

● Impromptu Administrator

Test Impromptu Web Reports - Server Administration
Verify that Impromptu Web Reports Server Administration is connected to the Impromptu Web

Reports server.

Steps

1. From the Start menu, click Programs, IBM Cognos Series 7 Version 4, IBM Cognos Server

Administration.

2. Click Reports.

The Connect dialog box appears.

3. Ensure that the Server box shows the name of the Impromptu Web Reports server, and then

click Connect.

4. Type the default user ID Administrator, leave the password blank, and click Log On.

5. In the left pane, expand Report Servers and click the name of your Impromptu Web Reports

server.

6. You can disable and enable the server from the Actions menu.

7. Close Impromptu Web Reports - Server Administration.

Test Impromptu Web Reports - Report Administration
To test Impromptu Web Reports Administration, create a NewsBox in Upfront and then publish

a sample report set to the NewsBox.

Steps to Create a NewsBox in Upfront

1. Open a Web browser and type the following URL to access Upfront:

http://server_name/cognos

If you did not use the default Web alias values, replace cognos with the appropriate Web alias.

2. If the Upfront Logon page appears, type the default user ID Administrator, leave the password

box blank, and click Log On.

3. In the NewsIndex, click New, and then click NewsBox.

4. In the Name box, type Great Outdoors, and click OK.
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5. Leave your Web browser open for the next procedure.

Steps to Publish a Sample Report Set

1. From the Start menu, click Programs, IBM Cognos Series 7 Version 4, IBM Cognos Server

Administration.

2. Click Report Publishing.

The Connect dialog box appears.

3. Ensure that the Server box shows the name of the computer where Impromptu Web Reports

is installed, and then click Connect.

4. Type the default user ID Administrator, leave the password blank, and click Log On.

5. From the Tools menu, click Publish Report Set.

The Publish Report Set dialog box appears.

6. Under Publishing options, click New report set and type a name to identify the report set you

will publish.

7. In the IWR Server Report Set Location box, type the path to the location where you want to

store the report set after it is published.

8. Beside the Source Directory box, click Browse to go to the sample reports.

The sample reports are located in the installation_location\samples\iwr\reports directory. These

sample reports are always installed on a Windows computer.

9. Click Select.

10. Beside the Publish reports to Upfront Newsbox box, click Select.

The Browse NewsBoxes dialog box appears.

11. Click the Great Outdoors NewsBox and then click OK.

12. In the Publish Report Set dialog box, click OK.

Publishing the report may take a few minutes.

A message appears stating that the report set is being published and that you can observe the

progress in the Status tab.

13. Click OK.

14. To view the publishing progress in the Status tab:

● From the View menu, click Refresh All.

● In the left pane, click the name of your report set.

● In the right pane, click the Status tab.

Repeat this step until the message in the right pane tells you that report set publishing has been

completed successfully.
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15. When publishing is finished, close Impromptu Web Reports - Report Administration.

16. In your Web browser, open the Great Outdoors Newsbox you created and observe that it now

contains the sample Impromptu Web Reports. You can open and view the sample reports.

17. Close your Web browser.

Test Impromptu Administrator
To test the installation of Impromptu Administrator, open a sample catalog. For instructions, see

"Test Impromptu Administrator" (p. 25).
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Chapter 7: Testing IBM Cognos Visualizer

You can perform the tests in this section to ensure that IBM Cognos Visualizer is installed correctly.

The test procedures assume that you used the installation guide to perform a default installation.

If you performed a custom installation, you may not have installed all the components required to

perform the tests.

The test procedures assume that you are using IBM Cognos sample data to test your installation.

If you use your own data, then file names, paths, and output will be different than described in the

test procedures.

The test procedures assume that you used the example values for user IDs, passwords, and install-

ation locations. If you used different values, you must replace the values in the test procedures with

your values.

If you encounter problems while performing the test procedures in this section, see

"Troubleshooting" (p. 51) for information about fixing common installation and configuration

problems.

Open a Sample Visualization
To test IBM Cognos Visualizer, open a sample visualization.

Steps

1. From the Startmenu, click Programs, IBM Cognos Series 7 Version 4, IBM Cognos Visualizer.

2. Click Open an existing visualization.

3. Go to the installation_location\samples\Viz directory.

4. Click Dashboard.viz, and then click Open.

The visualization opens.

5. Close IBM Cognos Visualizer.

By opening a sample visualization, you confirmed that your installation of the Windows version

of IBM Cognos Visualizer was successful.
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Chapter 8: Testing IBM Cognos Visualizer Web

You can perform the tests in this section to ensure that IBM Cognos Visualizer Web is installed

correctly. By performing the tests, you verify that the components are configured to interact properly.

The test procedures assume that you used the installation guide to perform a default installation.

If you performed a custom installation, you may not have installed all the components required to

perform the tests. If you performed a distributed installation, some components are installed on

other computers. To perform the test procedures in a distributed environment, you may need to

specify network paths to components that are installed on other computers.

The test procedures assume that you are using IBM Cognos sample data to test your installation.

If you use your own data, then file names, paths, and output will be different than described in the

test procedures.

The test procedures assume that you used the example values for user IDs, passwords, and install-

ation locations. If you used different values, you must replace the values in the test procedures with

your values.

If you encounter problems while performing the test procedures in this section, see

"Troubleshooting" (p. 51) for information about fixing common installation and configuration

problems.

Prepare to Test IBM Cognos Visualizer Web
To test the installation, you distribute and open a Web-based visualization. You open a visualization

using two methods:

● from the IBM Cognos Visualizer Web Table of Contents using IBM Cognos Visualizer Web

Client

● from Upfront using the IBM Cognos Visualizer Web Viewer

For more information about IBM Cognos Visualizer Web Client and IBM Cognos Visualizer Web

Viewer, see the IBM Cognos Visualizer Web Administrator's Guide.

To prepare IBM Cognos Visualizer Web, you set IBM Cognos security properties, provide links to

the IBM Cognos Visualizer Web Client installation, and add a sample visualization to the IBM

Cognos Visualizer server.

Set Security Properties
To distribute visualizations using Upfront, the Web environment must use IBM Cognos security.

Steps

1. To start IBM Cognos Visualizer Server Administration, from the Start menu, click Programs,

IBM Cognos Series 7 Version 4, IBM Cognos Server Administration.
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2. Click Visualizations.

The Visualization Server Logon dialog box appears.

3. In the Visualization Server box, verify or type the name of your IBM Cognos Visualizer server.

(Typically, your computer name is the default.) Click OK.

4. If you are prompted to secure the server, click Yes.

5. If the IBMCognos Common Logon dialog box appears, type the default user ID Administrator,

leave the password box blank, and click Log On.

6. In the Set Security dialog box, select user classes to set access privileges, and then click OK.

The server appears in the Visualization Servers list.

Provide Link to the IBM Cognos Visualizer Web Client Installation
To view Web-based visualizations using IBM Cognos Visualizer Web Client, report consumers must

install the Web Client, and if required, a compatible Java runtime environment. To provide access

to the required files, you add a link to the Web Client installation to the IBM Cognos Visualizer

Table of Contents, and to the error page that is displayed if a user attempts to access a visualization

without the required files.

Steps

1. In IBM Cognos Visualizer Administration, click File, Properties, Visualization Server.

2. On the Visualization Settings tab, select Show client install link on the Table of Contents and

Error Page.

3. Click OK.

A link, Install IBM Cognos Visualizer Web Client, is added to the Table of Contents and error

page.

Add a Visualization to the Server
Before you distribute a sample visualization, you must add the visualization to the server and enable

publishing to Upfront.

1. In IBM Cognos Visualizer Server Administration, click File, Add Visualization.

2. In the Name box on the Source tab, type Great Outdoors.

The text in the Name box appears as the visualization name in IBM Cognos Visualizer Server

Administration.

3. In the Description box, type Great Outdoors.

The text in the Description box appears as the visualization name in the Table of Contents,

and as the default entry name when you publish the visualization to Upfront.

4. Click Browse.
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5. Locate the sample visualization Dashboard.viz, and then click OK.

By default, samples are located in the installation_location/samples/viz directory.

6. In the Enable publish to box on the Availability tab, select Upfront.

7. Click OK.

You are now ready to test the IBM Cognos Visualizer Web environment.

Test IBM Cognos Visualizer Web
Report consumers can access Web-based visualizations from a Table of Contents or from Upfront.

The Table of Contents option is suitable for unsecured environments. By distributing visualizations

using Upfront, you can take advantage of IBM Cognos security.

Open a Visualization from the Table of Contents
You use IBM Cognos Visualizer Server Administration to create a Table of Contents. The Table of

Contents includes a link to the IBM Cognos Visualizer Web Client installation. After you install

the necessary Web client files, you can open a Web-based visualization.

Before you can complete the following test, you must prepare the IBM Cognos Visualizer environment

(p. 47).

Steps

1. In IBM Cognos Visualizer Server Administration, click Tools, Make Table of Contents.

The Table of Contents appears in a Web browser. The Table of Contents includes a link to the

Great Outdoors visualization, and a link to install the Web client.

2. Click Install IBMCognos VisualizerWeb Client, and then follow the instructions until the IBM

Cognos Visualizer Web autorun menu appears.

3. Click Install IBM Cognos Visualizer Web Client, and then follow the instructions to install the

required files.

If you do not have the required version of the Java plug-in, you are prompted to install the

required files before you install the IBM Cognos Visualizer Web Client.

4. When the installation is complete, close the IBM Cognos Visualizer Web Client autorun menu.

5. From the Table of Contents, click the Client option for Great Outdoors.

If you started a new Web browser session, enter the address of the Table of Contents. The

default address is http://computer_name/cognos/cgi-bin/vizcgi.exe

The Great Outdoors visualization appears in IBM Cognos Visualizer Web Client.
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Open a Visualization from Upfront
To distribute visualizations using a secured environment, you can use IBM Cognos Visualizer Server

Administration to publish visualizations to the IBM Cognos Web portal, Upfront. Report consumers

access the visualization by logging on to Upfront and selecting a visualization entry.

Before you can complete the following test, you must prepare the environment. For more information,

see "Prepare to Test IBM Cognos Visualizer Web" (p. 47).

Steps to Publish a Visualization to Upfront

1. In IBM Cognos Visualizer Server Administration, click the Great Outdoors visualization.

2. From the Tools menu, click Publish to Upfront.

The Upfront logon page appears.

3. Enter a user ID and password, and then click Log on.

To use the default user profile, enter administrator as the user ID and leave the password box

empty.

4. On the save page, select a destination NewsBox, and then click OK.

A message appears to confirm that the Upfront entry was created.

5. Click Close Window.

Steps to Open the Visualization from Upfront

1. In a browser, enter the location for Upfront.

The default address is cgi-bin/upfcgi.exe reached at http://computer_name/cognos.

2. Enter a user ID and password, and then click Log on.

Note: Upfront shows only the NewsBoxes and entries that you have permission to access. To

ensure that the destination NewsBox appears, use the same user profile that you used when

you published the visualization to Upfront.

3. Open the NewsBox that you selected when you published the visualization.

4. Click the Great Outdoors entry.

The Great Outdoors visualization appears in the IBM Cognos Visualizer Web Viewer.
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Chapter 9: Troubleshooting

This section provides troubleshooting information for common installation and configuration

problems.

Depending on the version of IBM Cognos products you installed, some topics in this chapter may

not apply to your situation.

If you still have problems after you read the troubleshooting information in this section, you can

contact Cognos Software Services. For information about customer support locations and programs,

see IBM Cognos on the Web on the Help menu of your product, or visit IBM Cognos on the Web

(http://www-01.ibm.com/software/data/cognos/).

The troubleshooting section provides

● a list of troubleshooting resources that you can use to help diagnose and fix installation and

configuration problems.

● descriptions of general problems. These descriptions provide solutions to help you diagnose

and fix many common problems.

● specific troubleshooting problems and solutions sorted into the following categories:

● "Cannot Log On" (p. 55)

● "Cannot Find a Component or Information" (p. 58)

● "Cannot Open a Component or Information" (p. 61)

● "Cannot Connect to a Component" (p. 64)

● "Cannot Start or Stop a Component" (p. 67)

● "Cannot Create, Publish, or Display Information" (p. 74)

● "Other Authentication Problems" (p. 87)

● "General Runtime or Installation Problems" (p. 88)

If you do not find your problem in a category, try another similar category. Some problems may

not be in the category you expect because some categories are similar. For example, a problem that

you might expect to find in the Cannot Connect to a Component category may be in the Cannot

Start or Stop a Component category.

Troubleshooting Resources
This section discusses the resources that you can use to resolve installation and configuration issues.

Licensed Materials – Property of IBM
51© Copyright IBM Corp. 1999, 2010.

http://www-01.ibm.com/software/data/cognos/


Configuration Manager
You can use Configuration Manager to diagnose and fix problems related to the configuration of

your components. For more information about using Configuration Manager, see the Configuration

Manager User Guide.

Access Manager - Administration
You can use Access Manager - Administration to verify the correct configuration of, and connection

to, your directory server and ticket service. From the Properties window of the directory server,

you can test whether the directory server and ticket service respond.

Windows Event Viewer
Windows Event Viewer provides information that might help you diagnose problems. For more

information about Windows Event Viewer, see the Windows online help.

Log Files
The following log files contain information that can help you fix installation and configuration

problems for IBM Cognos products:

● The transfer log file is a record of the activities that the Installation Wizard performed while

transferring files. The transfer log file is located in the installation_location/instlog folder on

Windows and UNIX. The file name identifies the product name, version, and build number,

and includes a time stamp. The following is an example of the file name format:

tl-PP-7-0-517-0-20011104_0942.txt

● The transfer summary-error log file is a record of what components were installed, disk space

information, the selections you made in the transfer dialog boxes, and any errors the Installation

Wizard encountered while transferring components. The transfer summary-error log is located

in the installation_location/instlog folder on Windows and UNIX. The file name identifies the

product name, version, and build number, and includes a time stamp. The following is an

example of the file name format:

tl-PP-7-0-208-0-20011106_1122_summary-error.txt

● The configuration activity report file is a record of all activities that Configuration Manager

performs. A configuration activity report file is created for each configuration session. The

report is located in the installation_location/instlog folder on Windows and UNIX. The file

name includes a time stamp. The following is an example of the file name format:

cfa-20011105_1652.txt

● The configuration error report file is a record of any warnings and errors that Configuration

Manager encountered during configuration. The report file is in the installation_location/instlog

folder on Windows and UNIX. The file name includes a time stamp. The following is an example

of the file name format:

cfe-20011106_1122.txt
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● The component list file is a record of all IBM Cognos components installed on your computer.

Each entry in the file consists of the component name and its build number. The component

list file is called cmplst.txt and is located in the installation_location folder.

General Problems
This section describes issues that are related to installation and configuration.

Configuration Values Not Applied
If you use Configuration Manager to change configuration values and you do not apply them, the

new values will not take effect and some components may not work properly.

To ensure that all configuration values have been applied, perform an apply on the computer after

you have configured your components.

Services Not Running
If you use Configuration Manager to change configuration values and you do not start all services,

some components may not work properly.

In a distributed environment, another person may have stopped a service after you started it. For

example, a server administrator may have stopped all services to perform an upgrade, and then

failed to restart all the services.

To ensure that all services are running, perform an apply and a start on the computer.

Port Numbers Do Not Match
Port numbers for components must be defined consistently. If the port number for a component is

defined as one value on the computer that provides the service, and as a different value on a computer

that attempts to access the service, the attempt will fail.

Use Configuration Manager to ensure that port numbers for components are defined consistently

across all computers running IBM Cognos components.

Failure to Change Default Values
When you install IBM Cognos products, certain configuration values exist by default. You may

need to change some configuration values, such as port numbers, to suit your environment. If you

need to change configuration values and fail to do so, some components may not work properly.

Lack of Connectivity Between Components
There are many possible causes for connectivity problems, including port number mismatches,

services not running, failure to install IBM Cognos components or third-party products, and basic

network connectivity failure, such as an unavailable host.
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Multiple Versions of the Server Configuration File
The server configuration file (cern.csx, where n is the IBM Cognos Series 7 rendition number)

contains server configuration information that enables the gateway components to find their asso-

ciated dispatchers.

We recommend you ensure that the same version of the server configuration file exists on each

computer in your distributed installation.

If you use more than one version of the file, some components may not be able to access services

on other servers.

Web Protocol for Relative URL Support
If your Web server uses the HTTP Web protocol and you have a proxy server such as a router or

firewall configured to use the HTTPS protocol, you may experience problems. Problems may occur

because your router or firewall may use accelerated SSL encryption technology.

To avoid this situation, do one of the following:

● If your proxy server uses the HTTPS protocol and your Web server uses the HTTP protocol,

ensure that you configure all IBM Cognos products to use relative URLs.

● Ensure that your Web server and proxy server use the same protocol.

● Ensure that your proxy server uses the HTTP protocol and your Web server uses the HTTPS

protocol.

ISO 8859-15 Encoding
This release supports ISO 8859-15 encoding. If your server runs on ISO 8859-15, the server has to

ensure that all reports on the server are writable.

A PowerPlay report is typically generated by PowerPlay for Windows. All characters saved in the

report are encoded with Windows-1252. Because the euro code point is different for Windows-

1252 and ISO 8859-15, PowerPlay needs to convert the report from Windows-1252 to ISO 8859-

15 the first time it is run.

Mounting IBM Cognos CDs Using the Rock Ridge Method
On HP-UX, if an IBM Cognos CD is not mounted using the Rock Ridge method, or if the Rock

Ridge procedure is not completed correctly, you may see unexpected results. For example, file names

may appear in all uppercase or all lowercase characters, or a semi-colon (;) or period (.) may appear

at the end of each file name.

To ensure that the Rock Ridge method works as expected, verify that

● you followed the procedures in the solution Installation Guide when mounting the CDs

● networking is properly configured, including network loopback

● nfs.core and nfs.client subsystems are running

● PATH includes the directory that contains the PFS utilities
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Microsoft Internet Explorer Blocks Active Content
When you click a help button that launches an HTML file, Internet Explorer may generate a

warning message that active content has been blocked as a security precaution. This can occur if

the button links to an HTML file on a local file system on a computer where Internet Explorer 6

is installed. The warnings are due to security features that Microsoft has implemented.

To resolve the issue, do one of the following:

● Click on the message, and select the option to allow the active content. Ensure that you are

opening an IBM Cognos help file before you select this option.

● Ensure that the Help Location properties in the Administration section in Configuration Manager

use a Web alias, such as http://computer_name/cognos/help, rather than a local file system path.

For more information, see the Configuration Manager User Guide.

Cannot Log On

Access Manager Server Ticket Service is Not Configured or Not Available
You may receive an error message telling you that the Access Manager Server ticket service is not

configured or is not available.

This problem can occur if the configuration values for the ticket service are incorrect, or if the ticket

service is not running.

Note: You can provide failover protection by installing and configuring additional Access Manager

authentication services.

Solution

1. From the Start menu, click Programs, IBM Cognos Series 7, Tools, Configuration Manager.

2. Expand Services.Access Manager - Server.General.Ticket Service.

3. Verify that the configuration values for the ticket service are correct and update them if necessary.

Note: The default port for the ticket service is 9010.

4. Perform an apply and a start on Services.Access Manager - Server.

5. Expand Services.Access Manager - Directory Server.General.

6. Do the following:

● Verify that the ticket service port number listed for Primary Ticket Service is the same as

the port number specified for Port in Services.Access Manager - Server.General.Ticket

Service.

● Verify that the computer name in Primary Ticket Service is the name of the computer where

the ticket service is installed.

7. Perform an apply on Access Manager - Directory Server.
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Unable to Log On Error Message
You may receive an error message when you try to log on to one of the following:

● Impromptu Web Reports - Report Administrator

● Impromptu Web Reports - Server Administrator

● PowerPlay Transformer

● PowerPlay Enterprise - Server Administration

The error message tells you that a network failure occurred while communicating with a server and

that there was an error encountered sending parameters to the server.

This problem may be caused by one of the following:

● "Configuration Values not Applied or Service not Running" (p. 56)

● "Incorrect Port Number Specified for the Impromptu Web Reports Server" (p. 56)

● "Access Manager Server is Not Running" (p. 57)

● "Directory Server is Not Running" (p. 57)

● "Base Distinguished Name Incorrectly Specified" (p. 57)

Configuration Values not Applied or Service not Running

The configuration values for components are correct, but either they have not been applied or the

service is not running.

In a distributed environment, another person may have stopped a service after you started it. For

example, a server administrator may have stopped all services to perform an upgrade, and then

failed to restart all the services.

Solution

Use Configuration Manager to perform an apply and a start on the server.

Incorrect Port Number Specified for the Impromptu Web Reports Server

When you try to log on to Impromptu Web Reports - Report Administration or Impromptu Web

Reports - Server Administration, the logon fails if the port number specified in the Connect dialog

box is incorrect. Note that the port number may not be visible in the Connect dialog box.

Solution

Determine the correct port number for Impromptu Web Reports server and use Configuration

Manager to verify that the port number is specified correctly. Then update the port number in the

Connect dialog box.

Steps

1. Determine the correct port number for accessing the Impromptu Web Reports server. The

default is 8020.
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2. Use Configuration Manager to verify that the Impromptu Web Reports server port number is

correct and change it if necessary.

On Windows, click the Server Configuration tab, expand All Server Groups, and then click

IWR Server Group.

On UNIX, go to Cognos Shared.Runtime Parameters.Server Configuration.Cognos Impromptu

Web Reports.IWR Server Group.

3. In Configuration Manager, perform an apply and a start on the server.

4. From the Startmenu, click Programs, IBMCognos Series 7, IBMCognos Server Administration.

5. Click either Reports or Report Publishing.

The Connect dialog box appears.

6. Type the correct server name and port number in the Server box in the following format:

server name:port number

7. Type your User ID and Password in the appropriate boxes and click Connect.

Access Manager Server is Not Running

The Access Manager Server that validates the user logon is not running.

Solution

Use the Services tool in Control Panel to verify that IBM Cognos Access Manager Server has the

Status set to Started, and the Startup set to Automatic.

Directory Server is Not Running

The directory server is not running.

Solution for Windows

Use the Services tool in Control Panel to ensure that all directory servers have the Status set to

Startedand the Startup set to Automatic.

Solution for UNIX

Type ps -ef | more to display the status of processes. If ns_slapd is not running, start it.

Base Distinguished Name Incorrectly Specified

The Base Distinguished Name (DN) specified for the directory server connection is incorrect.

Solution

1. From the Startmenu, click Programs, IBMCognos Series 7, IBMCognos Server Administration.

2. Click Security.

3. Expand Directory Servers, right-click your directory server, and click Properties.

The Directory Server Properties dialog box appears.
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4. On the General tab, click Test.

5. If a message appears that indicates the directory server is not responding, the host name or the

port number specified are not correct. Correct these values and click Test again.

6. If an error message appears telling you that the Base DN you have entered is wrong, type the

correct Base DN and click Test again.

Unable to Log On Using OS Signons and Microsoft IIS Server
If you encounter a failure to log on to Web-based IBM Cognos software using your Netscape

browser with OS Signons and Microsoft IIS Server, you might need to clear the Allow Anonymous

Access check box in the Internet Service Manager for Microsoft IIS.

Solution

1. From the Start menu, click Programs, Microsoft Personal Web Server, Internet ServiceManager.

The Microsoft Management Console dialog box appears.

2. In the left portion of the window, expand Internet Information Server and components below

it until you see Default Web Site.

3. Click Default Web Site and from the Action menu, click Properties.

The Default Web Site Properties dialog box appears.

4. Click the Directory Security tab.

5. In Anonymous Access and Authorization Control, click Edit.

6. Clear the Allow Anonymous Access check box and click OK.

7. Close the Default Web Site Properties dialog box and the Microsoft Management Console
dialog box.

Cannot Find a Component or Information

Cannot Find Samples Folder or Files
If the IBM Cognos samples folder or files cannot be found on the server, the IBM Cognos sample

files have not been installed. Perform a custom installation of the IBM Cognos sample files for your

product, and then perform the following steps.

Solution

1. From the Start menu, click Programs, IBM Cognos, Tools, Configuration Manager.

2. Perform an apply on Sample Databases.

Unable to Find a PDF Report
You may be unable to find a previously generated PDF report.

58 IBM Cognos Series 7 Version 5

Chapter 9: Troubleshooting



This problem can occur if you did not fully qualify the path for the ObjectStore location when you

generated the report. The path for the ObjectStore location might need to be fully qualified to ensure

the request server can locate the PDF files.

Solution

Modify the path for the ObjectStore location so that it is fully qualified.

● On Windows, an example path is as follows:

server.cognos.com:F:\Program_Files\Cognos\Cern\Database\iwr70.db

● On UNIX, an example path is as follows:

server.cognos.com:/home/usr/cognos/cern/database/iwr70

Do Not Know What Directory Server Ports are Being Used
If you forget your Sun Java System directory server port numbers, you can find them in configuration

files.

Solution for Windows

1. For the Sun Java System directory server, go to the directory where you installed the directory

server and open \Sun\MPS\admin-serv\config\adm.conf.

2. For the Sun Java System Directory Administration Server, go to the directory where you installed

the directory server and open \Sun\MPS\shared\config\ldap.conf.

Solution for UNIX

1. For the Sun Java System directory server, go to the directory where you installed the directory

server and open /var/Sun/mps/admin-serv/config/adm.conf.

2. For the Sun Java System Directory Administration Server, go to the directory where you installed

the directory server and open /var/Sun/mps/shared/config/ldap.conf.

Data Store Does Not Exist
The Impromptu Web Reports data store files may not have been created or may be corrupt.

Solution

Use the iwcreatedb program to create the data store files.

1. Ensure that the ObjectStore services are running:

● In Windows, open Control Panel, Services and verify that the ObjectStore Cache Manager

and ObjectStore Server services are started, and that startup is set to automatic.

● On UNIX, type ps -ef | more to display the status of processes. If osserver and oscmgr6 are

not running, start them.

2. Use Configuration Manager to stop the IBM Cognos IWR Service Manager service.
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Note: In the Configuration Manager hierarchy, the IBM Cognos IWR Service Manager is named

Server, and is located below IBM Cognos Impromptu Web Reports.

3. Do one of the following:

● On Windows, open a command prompt window and go to installation location/bin.

● On UNIX, go to the cern_location/bin directory and type the following command to set

up the environment:

../iwrsetup.sh

4. Type iwcreatedb, and use the -p parameter to specify the port number if you did not use the

default port 8020 when you installed Impromptu Web Reports.

For example, type iwcreatedb -p8111

Note: Do not use spaces between the parameter and its value.

5. Prepare to register the dispatchers:

● On Windows, open a command prompt window and go to cern_location/Program

Files/Cognos/cern/bin.

● On UNIX, go to cern_location/bin directory and type the following command to set up

the environment: ../iwrsetup.sh

6. Register the dispatchers:

● Type iwiwrdisp -register and press Enter to register your report dispatcher.

● Type iwirsdisp -register and press Enter to register your request dispatcher.

7. Repeat steps 5 and 6 for each computer in the server group.

8. Use Configuration Manager to restart the services for the Impromptu Web Reports servers in

the server group and the data store.

Cannot Find Server Configuration (cer .csx) File
When you apply the current configuration settings, you may receive an error message telling you

that the server cannot find the server configuration (cern.csx) file.

The problem may occur if you do not specify a property value for the Gateway URL in Configuration

Manager. The server configuration file (cern.csx) contains information so that gateway components

can communicate with their associated servers (dispatchers).

Solution

1. From the Start menu, click Programs, IBM Cognos Series 7, Tools, Configuration Manager.

2. At the bottom of the Explorer window, click the Server Configuration tab.

3. Under All Server Groups in the Explorer window, click the appropriate server group.
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4. In the Properties window, if the value in the Gateway URL field is blank, type the appropriate

setting.

5. In the Explorer window, click the computer name.

6. From the Actions menu, click Apply Topology.

Cannot Open a Component or Information

PowerPlay Server Not Available
When you try to use PowerPlay to open a cube or report, you may receive an error message telling

you that the PowerPlay server is not available.

This problem could be caused by one of the following:

● "PowerPlay Enterprise Server is Not Installed" (p. 61)

● "PowerPlay Enterprise Server is Not Running" (p. 61)

● "PowerPlay Enterprise Server is Not Configured Properly" (p. 61)

● "Lack of Connectivity Between Computers" (p. 62)

PowerPlay Enterprise Server is Not Installed

If PowerPlay Enterprise Server is not installed, you cannot open a remote PowerPlay cube or report.

Solution

Install PowerPlay Enterprise Server on the computer that you want to use as a PowerPlay Enterprise

server.

Steps

1. Install PowerPlay Enterprise Server from the Installation CD.

2. Use Configuration Manager to perform an apply and a start on the computer.

3. Ensure that a valid connection exists between your computer and the computer where PowerPlay

Enterprise Server is installed; that is, ensure you can ping the server.

PowerPlay Enterprise Server is Not Running

The PowerPlay Enterprise Server service is not running.

Solution

On the computer where PowerPlay Enterprise Server is installed, use Configuration Manager to

perform a start on the PowerPlay Enterprise Server.

PowerPlay Enterprise Server is Not Configured Properly

The configuration values for PowerPlay Enterprise Server are not correct for the environment.
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Solution

1. On the computer where PowerPlay Enterprise Server is installed, start Configuration Manager.

2. Verify that the configuration values for PowerPlay Enterprise Server are correct for the envir-

onment, and change them if necessary.

3. Perform an apply and a start on the server.

4. If you are in a distributed environment, ensure that a valid connection exists between your

computer and the PowerPlay Enterprise Server computer.

Lack of Connectivity Between Computers

There may be a lack of network connectivity between your computer and the server where PowerPlay

Enterprise Server is installed.

Solution

1. From your computer, ping the PowerPlay Enterprise Server by server name.

If the ping is successful, proceed to step 3.

2. If the ping is unsuccessful, from your computer, ping the PowerPlay Enterprise Server by IP

address.

If this ping is unsuccessful, there is a network problem or the PowerPlay Enterprise Server is

not running.

If this ping is successful and the ping by server name was unsuccessful, there is a problem con-

necting by server name. If the server name that you pinged in step 1 exists and is running, the

Domain Name System (DNS) may be unable to translate the server name to the correct IP

address. To resolve this, you may need to edit the host file.

3. Ensure that the PowerPlay Enterprise Server is running:

● On Windows, open Control Panel, Services and verify that IBM Cognos PowerPlay

Enterprise Server (cern) is started and startup set to automatic.

● On UNIX, type ps -ef | more to display the status of processes. If ppserver is not running,

start it.

4. Use Configuration Manager to verify that the configuration values for IBM Cognos PowerPlay

Enterprise Server are correct. Ensure that the correct path is specified for any components on

remote computers.

If you make any changes to configuration values, perform an apply and a start on the computer.

Cannot Open Model When Publishing to Upfront
When you try to publish a package to Upfront, you may receive an error message telling you that

the selected model cannot be opened.

You may also receive an error message telling you about one of the following conditions:

● ObjectStore server is probably not running.
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● A connection to the ObjectStore cannot be established.

This problem could be caused by one of the following:

● "ObjectStore is Not Installed or ObjectStore Services are Not Running" (p. 63)

● "Configuration Values for the Computer Have Not Been Applied" (p. 63)

ObjectStore is Not Installed or ObjectStore Services are Not Running

You cannot open a model if ObjectStore is not installed or if the ObjectStore services are not running.

Solution

Open Control Panel, Services and verify that the ObjectStore Cache Manager and ObjectStore

Server services are started, and that startup is set to automatic.

If the ObjectStore services are not listed in Services, you must install ObjectStore from the installation

CD. See the installation guide for more information about installing ObjectStore.

Configuration Values for the Computer Have Not Been Applied

You cannot open a model if the configuration values for the computer have not been applied.

Solution

In Configuration Manager, perform an apply on the computer.

No Access to Database
You may receive an error message that tells you that you do not have access to a database and tells

you to check with your administrator.

This occurs if you log on with a user ID that does not have the privileges required to access the

requested database or files. This problem can be caused by the following:

● "Logged in with the Incorrect User ID" (p. 63)

● "Your User ID Does Not Have Correct Access Privileges" (p. 63)

Logged in with the Incorrect User ID

You logged on with a User ID that does not have privileges to use the requested database or files.

Solution

Log out of Access Manager and then log in with a user ID that has privileges to use the requested

database or files.

Your User ID Does Not Have Correct Access Privileges

Your user ID does not have access privileges for the requested database or files. If you previously

had access, your password may have expired.

Solution

Contact your administrator to request access to the database or files.
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Unable to Open Server Model Due to Incorrect or Missing DataSource Path
If your Transformer for UNIX model uses an ASCII data source, and you do not correctly specify

the server path, the system may assign one, thereby introducing character-case errors.

Solution

Ensure that you properly specify the server path, using the correct character case, to allow your

ASCII datasource models to open without error, in the Transformer for UNIX environment.

Cannot Connect to a Component

Cannot Load Apache Module into Server When Using ReportNet and Impromptu
Web Reports on the Same Web Server

When configuring an Apache gateway for Impromptu Web Reports on a Web server that is also

being used for ReportNet, the Web server may not start. You may see a message similar to the fol-

lowing:

Syntax error on line 557 of /<machinename>/webserver/IHS_###/conf/httpd.conf: Cannot load /

usr/cognos/cgi-bin/imrapmod.so into server: Exec format error

In your Web browser, you may see the following message:

500 Internal Server Error in the browser:

The server encountered an internal error or misconfiguration and was unable to complete your

request.

Please contact the server administrator, name@company.address and inform them of the time the

error occurred, and anything you might have done that may have caused the error. More information

about this error may be available in the server error log.

The problem occurs because of incompatibilities between shared libraries used by the two gateway

modules. Both gateway modules are loaded by one process, Apache Web server. A single Apache

Web server cannot load both the Impromptu Web Reports and ReportNet modules.

Solution

To resolve this problem, run each gateway module in a separate Apache process.

For example, configure the first instance of Apache as the proxy server and to load mod_cognos

for ReportNet. Configure the second instance to run the Impromptu Web Reports gateway module.

Steps

1. Enable mod_proxy on the original Apache Web Server.

This server becomes the proxy server.

2. Install and configure a second instance of Apache on a different port.

3. On the original server, do the following:
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● Remove any existing Impromptu Web Reports configuration information from the httpd.conf

file and then add the following information:

LoadModule proxy_module modules/mod_proxy.so # modify to suit platform

<Location /cognos/cgi-bin/imrapmod>

ProxyPass http://hostname:port/cognos/cgi-bin/imrapmod

</Location>

● Edit the Apache envvars file and ensure that crn/cgi-bin appears before the cer4/bin and

cer4/cgi-bin directories in the shared library search path.

4. On the second server, do the following:

● Configure the Apache module gateway settings that are required for Impromptu Web

Reports.

For more information, see the Change the Apache Web Server Settings for Apache Module

Gateways topic in Configuration Manager User Guide.

● Configure the server to use the same port as the one specified in the ProxyPass line in step

3.

● Edit the Apache envvars file and ensure that crn/cgi-bin is not in the shared library search

path.

Unable to Connect to Upfront Server
When you attempt to publish to Upfront, you may receive an error message telling you that you

are unable to connect to the Upfront Server.

This problem could be caused by one of the following:

● "No Connectivity with the Server" (p. 65)

● "Upfront Services are Not Running" (p. 66)

No Connectivity with the Server

Your computer cannot establish a connection with the dispatcher.

Solution

1. From your computer, ping the Upfront server by computer name.

If the ping is successful, proceed to step 3.

2. From your computer, ping the Upfront Dispatcher computer by IP address.

If this ping is unsuccessful, there is a network problem or the Upfront server is not running.

If this ping is successful and the ping by computer name was unsuccessful, there is a problem

connecting by computer name. If the computer name that you pinged in step 1 exists and is

running, the Domain Name System (DNS) may be unable to translate the computer name to

the correct IP address. To resolve this, you may need to edit the host file.
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3. Use Configuration Manager to verify that the configuration values are correct. Ensure that a

complete path is specified for any components on remote computers.

If you make any changes to configuration values, perform an apply and a start on the computer.

4. In the Publish to Upfront Wizard dialog box, click Cancel.

5. In theModel Explorer pane, right-click the package to be published and click Publish to Upfront.

6. Type the correct Upfront dispatcher host name and click Next.

The Publish to Upfront Wizard connects to the dispatcher.

Upfront Services are Not Running

The Upfront services are not running. They may have been stopped or may not have been started

properly.

Solution

Ensure that the Upfront services are running and then publish to Upfront.

Steps

1. Ensure that the Upfront services are running

● On Windows, open Control Panel, Services and verify that all Upfront services are started

and the startup set to automatic.

● On UNIX, type ps -ef | more to display the status of processes. If upfdbsrv, UpfDispatch-

erService, UpfServer, and UpfEventServer are not running, start them.

2. In the Publish to Upfront Wizard, click Cancel.

3. In the Model Explorer pane, right-click the package to be published and click Publish to Upfront.

4. Type the correct Upfront dispatcher host name and click Next.

The Publish to Upfront Wizard connects to the dispatcher.

Cannot Connect to Servers, Nothing is Responding, and Similar Observations
After Installing on UNIX

You are experiencing processes not running while you expect them to be. This can occur if your

UNIX server has been rebooted and the services are not restarted automatically as part of the boot

script. If others are advising you of these problems, have the administrator add to the boot script,

or advise you whenever the server is rebooted so you can take immediate action for your customers.

Solution

1. Type ps -ef | more to check which processes are running.

2. Start all relevant processes.
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Configuration Manager Apply Error with Access Manager - Runtime
You received an error when you performed an apply because you have a new directory server that

is not configured with the IBM Cognos schema.

Solution

Configure the directory server to extend the schema for IBM Cognos products.

Steps

1. Start Configuration Manager.

2. Go to Access Manager - Directory Server.

3. Ensure the property values reflect the configuration of the directory server. Refer to the

installation guide for information about configuring your directory server.

4. Perform an apply on Access Manager - Directory Server.

5. Perform an apply on Access Manager - Runtime.

Cannot Start or Stop a Component

Unable to Open Requested Application When Starting Upfront
When you start Upfront, you may receive a message telling you that the requested application

cannot be opened.

This problem can occur if you are trying to start a service that is not running.

Solution

Use Configuration Manager to perform an apply and a start on the computer where Upfront is

installed.

OLE Initialization Failed
You may receive an error message telling you that OLE initialization has failed and to make sure

the OLE libraries are the correct version.

This problem can occur if you install other (non-IBM Cognos) software that overwrites a dynamic

link library (.dll) file with an older version of the same file.

Solution

Uninstall the affected IBM Cognos product and then install it. The newer version of the .dll file will

automatically replace the older one. Your other software should still work properly with the newer

.dll file.
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PowerPlay Enterprise Server Not Available
When you try to start PowerPlay Enterprise Server and connect to it, you may receive an error

message telling you that the server is not available.

This problem can occur if the name of the computer where the PowerPlay Enterprise Server dispatcher

is installed is not correctly specified in Configuration Manager. It can also occur if the port number

for the PowerPlay Enterprise server is specified incorrectly.

Solution

Verify that the name of the PowerPlay Enterprise Server dispatcher computer is specified correctly

in Configuration Manager.

Verify that the port number for the PowerPlay Enterprise Server is specified correctly in Configur-

ation Manager.

Steps to Verify the Name of the Dispatcher Computer

1. Obtain the name of the computer where the PowerPlay Enterprise Server dispatcher is installed.

2. In Configuration Manager, expand IBMCognos PowerPlay Enterprise Server.Dispatcher.Gen-

eral.

3. Update the PowerPlay Server Name if necessary.

4. Perform an apply and a start on the server.

Steps to Verify the PowerPlay Enterprise Server Port Number

1. Obtain the port number used for the PowerPlay Enterprise Server dispatcher on the computer

where it is installed.

2. From the Start menu, click Programs, IBM Cognos Series 7, Tools, Configuration Manager.

3. Expand Cognos PowerPlay.Enterprise Server Dispatcher.General.

4. Verify that the PowerPlay Server Port Number is correct and change it if necessary.

5. If you changed the port number, click Dispatcher, perform an apply.

6. With Dispatcher selected, perform a Stop and then Start.

Unable to Start Upfront
When you try to start Upfront, you may receive an error message that refers to an internal Upfront

server error.

This problem occurs if the directory server is not running.

Solution

Use Configuration Manager to perform an apply and a start on the computer where the directory

server is installed.
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Unable to Start Access Manager Server
You may be unable to start the Access Manager Server from the Services tool in Control Panel.

This problem occurs if the Access Manager Server is not registered with Windows.

Solution for Windows

1. Start Configuration Manager.

2. Expand Services.Access Manager - Server.

3. Right-click Access Manager - Server and click Start.

Solution for UNIX

Navigate to the installation_location/bin directory and type the command amserver -help.

Determine the command to run for your environment.

Request to Run PowerPlay Enterprise Server Failed
You may receive an error message telling you that a request to run PowerPlay Enterprise Server

failed because PowerPlay Web was unable to create a temporary file.

This problem occurs when read/write permissions are set incorrectly for the installation_location\

webcontent\ppwb\temp directory or the installation_location\ppservertemp directory.

Solution

1. Provide the user running the Web server with read/write access to the installation_location\

webcontent\ppwb\temp directory and the installation_location\ppservertemp directory.

2. Search for the installation_location\ppservertemp directory.

This directory is created by PowerPlay User, and therefore may not exist on computers where

PowerPlay Enterprise Server is installed without PowerPlay User.

If the directory exists on your computer, provide the user running the Web server with read/write

access to the directory.

Unable to Start Transformer
If you try to start Transformer, you may receive a message telling you that a dynamic link library

file (06CLIENT1.dll) could not be found.

This problem occurs if you performed a custom installation that includes Transformer without

installing ObjectStore and did not configure the components.

Solution

1. Install ObjectStore from the installation CD.

2. From the Start menu, click Programs, IBM Cognos Series 7, Tools, Configuration Manager.

3. Perform an apply and a start on the computer.
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Access Manager Server Ticket Service Not Configured or Not Available When
Using Impromptu Web Reports

You receive an error message that indicates the Access Manager Server ticket service is not configured

or available when starting Impromptu Web Reports Server Administration or Impromptu Web

Reports Report Administration.

This problem could be caused by one of the following:

● "Access Manager Server Ticket Service Not Installed" (p. 70)

● "Access Manager Server Ticket Service Not Configured Properly" (p. 70)

● "Access Manager Server Ticket Service Not Running" (p. 70)

Access Manager Server Ticket Service Not Installed

You have installed an IBM Cognos product that requires an Access Manager Server ticket service

but have not installed an Access Manager Server and configured it to run its ticket service.

Solution

Install the Access Manager Server from the product installation CD and configure it to run its ticket

service.

Access Manager Server Ticket Service Not Configured Properly

The Access Manager Server ticket service is unable to function with the current configuration

properties. This problem is typically caused by a font conflict. Try an alternate font.

Solution

1. Verify or correct the Access Manager Server ticket service configuration properties, such as the

port number, using Configuration Manager.

2. Using Configuration Manager, perform an apply and a start on Services.Access Manager -

Server.

Access Manager Server Ticket Service Not Running

The Access Manager Server for the ticket service has not been started.

Solution

Using Configuration Manager, perform an apply and a start on Services.Access Manager - Server.

Unsatisfied Link Error When Starting NoticeCast Dispatcher on AIX
If you encounter an error about an unsatisfied link when starting the NoticeCast dispatcher, the

problem could be with the IBM Java build. The problem has been corrected in build number

20010413 or PTF 6 onwards.

Solution

Update the version of Java installed on your AIX computer.
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NoticeCast Data Store Does Not Start When Connecting to a Data Store Within
an SQL Server Database

You tried to start NoticeCast data store on UNIX connecting to a data store within an SQL server

database and encountered an error. The NoticeCast log file, ncerr.log, reports problems with failed

logon and not being associated with a trusted SQL server connection. The problem is that the SQL

server database and authentication are set for Windows only.

Solution

1. Start SQL Server Enterprise Manager Console.

2. Right-click the server name and click Properties.

3. Click the Security tab.

4. Click SQL Server and Windows Authentication and click OK.

Unable to Start NoticeCast Server on UNIX
Starting the NoticeCast server (ncserver.exe) on a UNIX computer is not successful and the error

log file (ncerr.log) shows a ClassDefNotFound message. It is possible that you do not have Sun

Java Virtual Machine installed, or you require a version newer than 1.3.0, or the path for it is not

defined.

Solution

1. Go to the installation_location/bin directory.

2. Type java -version

3. If no version is displayed, or a version earlier than 1.3.0 is displayed, contact your UNIX system

administrator to have Sun Java Virtual Machine version 1.3.0 or higher installed.

If you receive a command not found error, contact your UNIX administrator to have the path

added to the computer.

NoticeCast Server Fails to Start
You cannot start the NoticeCast server and the error log (ncerr.log) shows a message telling you

that the port is already in use. Another service is already using the port number for the data store

or the dispatcher.

Solution

1. From the Start menu, click Programs, IBM Cognos Series 7, Tools, Configuration Manager.

2. Expand Cognos NoticeCast.NoticeCast Server.NoticeCast Server.

3. If the error message showed port 10999, change the Data Store port number in the NoticeCast

Data Store Port parameter.

4. If the error message showed port 10998, change the Dispatcher port number in the NoticeCast

Dispatcher parameter.
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NoticeCast Server Does Not Start After Installation of Another IBM Cognos
Product

You installed NoticeCast, configured NoticeCast parameters using Configuration Manager, then

installed another IBM Cognos Series 7 product. You applied the default configuration parameters

after the last installation and NoticeCast does not start. The problem is that the apply of your

default configuration resets all your configuration values, including those for NoticeCast.

Solution

1. Use Configuration Manager to check all NoticeCast configuration changes for your environment.

2. Save your configuration parameter values in Configuration Manager.

3. If you will be installing another IBM Cognos product, click the option to configure the product

manually.

Host Refused Connection Starting Configuration Manager on UNIX
You have Impromptu Web Reports installed and encounter an error condition referring to no

handler for exception, server refused the connection, and connection for the local computer is open.

You are presented with three choices of action. Also, you have previously successfully started and

configured a connection to ObjectStore and your Impromptu Web Reports data store. When Con-

figuration Manager is started, it tries to connect to ObjectStore to read properties so you can con-

figure them.

The error may occur if ObjectStore services are not running.

Solution

Start the ObjectStore services.

Steps

1. Close Configuration Manager.

2. On the Impromptu Web Reports data store computer, start the two ObjectStore services osserver

and oscmgr6.

3. From the Start menu, click Programs, IBM Cognos Series 7, Tools, Configuration Manager.

NoticeCast Data Store Does Not Start Automatically onWindows 2000 Computers
Your NoticeCast data store service shows the status of starting when the Windows or 2000 computer

is restarted. You can manually start the service using the Services tool in Control Panel. The problem

is with the order of services started by Windows. The NoticeCast data store service starts and

attempts to connect to the data store before the database service has started. This results in a failed

connection and NoticeCast data store is unable to complete startup.
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Solution

Define a service startup dependency for NoticeCast data store in the Registry Editor.

Steps to Define Startup Dependency

1. From the Start menu, click Run.

2. Type regedt32.exe (NOT regedit) and click OK.

3. In the Registry Editor window, go to the HKEY_LOCAL_MACHINE, SYSTEM, CurrentCon-

trolSet, Services and click theIBM Cognos NoticeCast Data Store (cern) key.

4. From the Edit menu, click Add Value.

5. Type DependOnGroup in the Value Name field, click REG_MULTI_SZ for the Data Type,

and then click OK.

6. In the Multi-String Editor window, click OK without typing any value.

7. From the Edit menu, click Add Value.

8. Type DependOnService in the Value Name field, click REG_MULTI_SZ for the Data Type,

and then click OK.

9. In the Data field of the Multi-String Editor window, type the name of the database service. You

will find the name in the HKEY_LOCAL_MACHINE, SYSTEM, CurrentControlSet, Services
list. It will depend on the database you are using. For Microsoft SQL Server, the name should

look like MSSQLServer. For Oracle, the name should look like OracleServiceoraclename, where

oraclename is the name of your Oracle database instance. For IBM DB2, the name should look

like DB2.

10. Click OK to save the value.

11. Close the Registry Editor.

12. Reboot the computer.

13. If the database starts properly, you have solved the problem.

If the database takes a very long time to start, even the above modification may not be adequate

and you will have to take additional steps.

Additional Steps

Perform the following steps only if you have performed the steps in "Steps to Define Startup

Dependency" (p. 73) and found them inadequate.

1. On Windows 2000, from the Services tool in Control Panel, double-click IBM Cognos

NoticeCast Data Store (cern). On the Recovery tab, click Restart the Service entry from the

First failure drop down control. Click Apply and OK. This procedure causes NoticeCast Data

Store to restart if a start failure occurs in future.

2. Click IBM Cognos NoticeCast Data Store (cern), click Stop, and click OK to confirm your

selection.
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3. Click Start and then close the Services tool.

Cannot Create, Publish, or Display Information

Cannot Open a File
If you cannot open an IBM Cognos sample file or one of your own files, the problem could be

caused by one of the following:

● file access permissions do not permit you to open an IBM Cognos sample file

● sample files are not installed properly or cannot be read

● your file was created with a previous version

● incorrect database driver

● no connectivity with a data server

File Access Permissions Do Not Permit Opening an IBM Cognos Sample File

If you installed the IBM Cognos sample files but cannot open them, you might not be a member of

a user class (on Windows) or user group (on UNIX) that has access to the IBM Cognos sample files.

Solution

● Ask your server administrator to verify that the access permissions for the IBM Cognos sample

files include you.

Samples Files are Not Installed Properly or Cannot Be Read

If you installed the IBM Cognos sample files but cannot open them, the installation wizard may

have encountered problems while installing the IBM Cognos sample files.

You can look at the transfer log error file for entries that identify problems transferring the IBM

Cognos sample files to your computer. The transfer log file is located in the installation location.

The file name includes the product name, the build number, and a date stamp. Below is an example

of the filename format:

tl-PP-7-0-517-0-20011104_0942.txt

Solution

● Perform a custom installation of the IBM Cognos samples files for the product.

File was Created with a Previous Version

If your file was created with a previous version of IBM Cognos software, it may not be compatible.

Solution

● Follow the upgrade procedures in the installation guide to make your data and model files

compatible with the current version.

74 IBM Cognos Series 7 Version 5

Chapter 9: Troubleshooting



No Connectivity with a Data Directory Server

There may be problems with the connection between your computer and a data directory server.

Possible problems include incorrect port numbers and network connectivity problems.

Solution

1. From your computer, ping the server by computer name.

If the ping is successful, proceed to step 3.

2. From your computer, ping the server by IP address.

If this ping is unsuccessful, there is a network problem or the server is not running.

If this ping is successful and the ping by computer name was unsuccessful, there is a problem

connecting with the server name. If the server name that you pinged in step 1 exists and is

running, the Domain Name System (DNS) may be unable to translate the server name to the

correct IP address. To resolve this, you may need to edit the hosts file.

3. Use Configuration Manager to verify that the configuration values, such as port numbers and

server names, are correct.

4. If changes are necessary, stop the service, make any necessary changes, and then perform an

apply and a start on the computer.

Unable to Publish to Upfront
You may receive an error message telling you there was a failure to receive a ticket when you try

to publish to Upfront.

The error message appears if the dispatcher does not receive authorization from the ticket service.

This problem can occur if the Access Manager Server for the ticket service is not running, or the

configuration values are set incorrectly.

Solution

1. From the Start menu, click Programs, IBM Cognos Series 7, Tools, Configuration Manager.

2. Expand Services.Access Manager - Server.General.Ticket Service.

3. Verify that the configuration values for the Access Manager Server and its ticket service are

correct and update them if necessary.

4. Perform an apply and a start on Access Manager - Server.

Message Tunnel Failure While Publishing Report Set
If you try to use Impromptu Web Reports - Report Administration to publish a report set, you may

get the following error message:

Request to obtain list of report sets failed on the server. Message Tunnel request failed. Message

Tunnel failed to connect the URL. Reason: Error encountered sending parameters to server.

This problem can occur if the Impromptu Web Reports Service Manager service is not running.
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Solution for Windows

● Open Control Panel, Services and verify that IBMCognos IWR ServiceManager (cern) services

has started and that startup set to automatic.

Solution for UNIX

● Type ps -ef | more to display the status of processes. If iwreqman, iwschman, iwirsdisp, and

iwirwrdisp are not running, start them.

Multi-Page Report Does Not Display Properly
If you use Impromptu to view a report in page layout view and then switch to screen layout view,

the report may not display properly and you may be unable to switch back to page layout view.

This problem occurs if there is no printer driver installed on your computer or if no printer driver

is designated as default.

Solution

1. Ensure that you have at least one printer driver installed.

2. Designate a printer driver as the default printer driver.

Special Characters in Report Titles Not Displayed Properly When PowerPlay Web
Report Exported to Microsoft Excel

If you add special characters such as ampersands or euro symbols to report titles in PowerPlay Web,

these characters may not display properly in the header of an exported Excel file. This problem

only occurs if the administrator has configured the PPSRoot.cfx file in the installation_loca-

tion\cern\ppserver directory to say the following:

ExcelTitleInWorksheet="IN,Y,0"

This setting specifies that titles appear in the Excel header instead of the first line of the Excel

worksheet.

Solution

To avoid this problem, specify that titles appear in the first line of the exported Excel worksheet,

instead of the header, by resetting to the default value in the PPSRoot.cfx file as follows:

ExcelTitleInWorksheet="IN,Y,1"

PDF Report Opens in New Window
If you use your Web browser to open a report that was saved as a PDF, it may open in a new window

instead of within your Web browser.

This problem can occur if you installed Adobe Acrobat Reader before you installed your Web

browser. Your Web browser was not updated to work with Adobe Acrobat Reader.
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Solution

Install Adobe Acrobat Reader from the installation CD or from the Adobe Web site. If prompted

to update your browser to work with Adobe Acrobat Reader, click Yes.

Unable to Publish Reports to Another Computer
You may be unable to use Impromptu Web Reports - Report Administration to publish reports to

another computer because of connection problems between your computer and the Impromptu

Web Reports server on the other computer.

This problem could be caused by one of the following:

● "Universal Naming Convention Not Used to Specify Server and Partition" (p. 77)

● "Impromptu Web Reports Services Set to Start as System Account" (p. 77)

Universal Naming Convention Not Used to Specify Server and Partition

When you specify a report set location, you may experience connection problems between your

computer and the Impromptu Web Reports computer if you do not follow the Universal Naming

Convention (UNC) to specify the server and partition.

If you choose to use a mapped drive instead of following the UNC, you must ensure that the mapping

will still be in effect after the computer is restarted.

Solution

When you publish a report, follow the UNC to specify the report set location. The UNC format is

as follows:

\\server name\path\folder

Impromptu Web Reports Services Set to Start as System Account

When using the Universal Naming Convention (UNC) to specify the report location on another

computer, ensure the Impromptu Web Reports services are set to start as a user account and not a

system account. A system account cannot write to a shared location. The services are installed with

the default value set to system.

Solution

1. On the computer where the Impromptu Web Reports services are installed, open Control Panel,

Services and change the Impromptu Web Reports services to start using a user account. If you

have multiple servers in your server group, you must ensure you select the same user account

name for all servers.

2. Ensure this account has sufficient access rights to the files and locations you are using.

3. Use Configuration Manager to perform an apply and a start on the server.

Installation Testing and Samples Setup Guide 77

Chapter 9: Troubleshooting



Report Elements Not Active
If you view a report or cube on your Web browser remotely using PowerPlay Enterprise Server,

you may be unable to manipulate the toolbar or perform drill-downs, or you may see a message

that indicates a server mirroring error.

This problem can occur when an environment with mirrored servers is only partially upgraded.

The cube you are trying to access is not located on the specified server. It is located on a mirrored

server that is running an earlier version of PowerPlay Enterprise Server. IBM Cognos Series 7 Version

4 PowerPlay Enterprise Server does not mirror to servers running earlier versions of PowerPlay

Enterprise Server.

Solution

Upgrade all PowerPlay Enterprise Servers in your mirrored environment to IBM Cognos Series 7

Version 4.

Unable to View Impromptu Web Reports
If you are unable to view any reports using Impromptu Web Reports, your administrator user, or

your namespace root administrator user basic signon information could be corrupted or might not

be set up correctly.

Solution

Access the user profile and verify or correct the basic signon information.

Database Create Error
If you encounter a database creation failed error after installing Impromptu Web Reports on UNIX,

the problem could be caused by one of the following:

● "ObjectStore Server Process Not Running" (p. 78)

● "ObjectStore Cache Manager Launcher Not Configured Properly in UNIX" (p. 79)

ObjectStore Server Process Not Running

If the ObjectStore server process is not running, you are not able to access any database files. You

need to start ObjectStore and reinstall Impromptu Web Reports.

Solution

1. Log on as root.

2. Check to see if the ObjectStore Server process is running by using the command ps -ef|grep

osserver

3. If it is not running, start it by using the command /etc/rc2.d/S80ostore4_start

4. Reinstall Impromptu Web Reports.
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ObjectStore Cache Manager Launcher Not Configured Properly in UNIX

If your ObjectStore server process is running, perform the following procedure to configure your

ObjectStore cache manager.

Solution

1. Log on as root.

2. Type setenv OS_ROOTDIR/opt/ODI/ostore

3. Type setenvLD_LIBRARY_PATH/opt/ODI/ ostore/lib

4. Type /opt/ODI/ostore/bin/osconfig check

5. Ensure the cache manager launcher has correct modes and ownership. If it does not, reinstall

and reconfigure ObjectStore server.

6. Reinstall Impromptu Web Reports.

Problems Publishing from PowerPlay Enterprise Server Administration

Cannot Publish to Upfront

If you cannot publish to Upfront using PowerPlay Administrator, the problem could be caused by

PowerPlay Enterprise Server being secured against the wrong namespace (that is, a namespace other

than the Upfront namespace) or a corrupt PPSRoot.cfx file.

Solution

1. Go to the installation_location\ppserver directory.

2. Delete the PPSRoot.cfx file.

3. In Configuration Manager, stop and start PowerPlay Enterprise Server to create a new PPS-

Root.cfx file.

4. Configure PowerPlay Enterprise Server to use the same namespace as Upfront.

Cannot Publish to ReportNet

If you cannot publish to ReportNet using PowerPlay Administrator, the problem could be caused

by configuration differences between IBM Cognos Series 7 and Cogons ReportNet or IBM Cognos

8 for the naming format used to identify the location of the IBM Cognos Series 7 namespace. Host

name or IP address are valid naming formats for the computer location. However, if one product

is configured using host name, and the other product is configured using IP address, publishing will

fail

Solution

Ensure that IBM Cognos Series 7 and IBM Cognos ReportNet or IBM Cognos 8 use the same

naming format for the computer location of the IBM Cognos Series 7 namespace.

For more information, see the IBM Cognos Series 7 Configuration Manager User Guide, and the

IBM Cognos ReportNet or IBM Cognos 8 Cognos Configuration User Guide.
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No Response When Requesting a Report Using a Web Browser
You have an environment in which your gateway service is not located on the local host computer

(for example, Impromptu Web Reports). Your request for a report is not executed. It is possible

the gateway server parameter has not been changed from the default value of the local server.

Solution

Using Configuration Manager, ensure the value for the gateway is correct.

Unable to Use ObjectStore as an Impromptu Web Reports Data Store When
Installed on a Different Computer

Your problem is similar to the Impromptu Web Reports drill through when viewing a report and

you are operating in a distributed environment. The Impromptu Web Reports server is not able to

access the ObjectStore data store located on another server.

The problem occurs if the server location does not use a fully qualified server name. This solution

is beyond those identified in the problem discussing opening a model because the local ObjectStore

is not running. The conditions described in that problem could apply here as well if the fully qualified

server name is specified.

Solution

Using Configuration Manager, change the IBM Cognos Impromptu Web Report.Common.Data-

base.Data Store Host property to specify a fully qualified server name. An example of this is:

Servername.Cognos.com:d:\database\iwr_db

Data Source Cannot be Accessed, Error with NoticeCast Save
If you try to save a data source using NoticeCast, you receive an error telling you the data source

cannot be accessed and to check the user name and password. The access and logon information

specified could be incorrect. This problem can be caused by one of the following:

● "User Logon ID or Password is Incorrect" (p. 80)

● "JDBC Driver Not Available to Link to the Target Database" (p. 81)

User Logon ID or Password is Incorrect

The user logon ID or password is not valid.

Solution

1. Check with your database administrator to see that the user ID and password are correct.

2. Save the data source.

3. If the specified user id and password are correct and the problem persists, check the JDBC

driver link to the data source.
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JDBC Driver Not Available to Link to the Target Database

If the target database is different from the NoticeCast data store database, then no JDBC driver is

available to link to the target database. Configuration parameters must be updated.

Solution

1. From the Start menu, click Programs, IBM Cognos Series 7, Tools, IBM Cognos Server

Administration.

2. Click Alerts and Notifications to run NoticeCast Server Administration.

3. From the Tools menu, click Maintain Databases.

4. Click the database connection and from the File menu, click Edit.

5. In the Path box, type or copy the location and file name of the JDBC driver for your database.

6. Click Test to test the connection.

7. Click OK to close the Maintain Databases dialog box.

Sample PowerPrompts Fail on UNIX
If you run the sample report queryreport.xxm by connecting to a UNIX server through a Windows

client, it fails.

This problem occurs because the report attempts to connect to the Windows version of the GOSales

sample database instead of the UNIX version.

Solution

Use Impromptu Administrator to delete the logical database and recreate it.

To do this, perform the procedure that corresponds to the software you used to create the sample

databases on UNIX.

Steps for Sample Database Created with Oracle

1. From the Start menu, click Programs, IBM Cognos Series 7, IBM Cognos Impromptu Admin-

istrator.

If the Welcome dialog box appears, close it.

2. From the Catalog menu, click Databases.

The Database Definition Manager dialog box appears.

3. Expand ODBC, click GOS, and click Delete.

The logical database is deleted.

4. Click Oracle and click New Database.

The Database Definition dialog box appears.

5. In the Logical database name box, type GOS
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6. In the SQL *Net connect string box, type the name of the server where the UNIX sample

databases are installed.

7. Click Test.

The Attach to Database dialog box appears.

8. Type a valid user ID and password to access the database and click OK.

9. In the Database Definition dialog box, click OK.

Steps for Sample Database Created with DB2

1. From the Start menu, click Programs, IBM Cognos Series 7, IBM Cognos Impromptu Admin-

istrator.

If the Welcome dialog box appears, close it.

2. From the Catalog menu, click Databases.

The Database Definition Manager dialog box appears.

3. Expand ODBC, click GOS, and click Delete.

The logical database is deleted.

4. Click DB2 and click New Database.

The Database Definition dialog box appears.

5. In the Logical database name box, type GOS

6. In the DB2 Database name box, type gosales

7. Click Test.

The Attach to Database dialog box appears.

8. Type a valid user ID and password to access the database and click OK.

9. In the Database Definition dialog box, click OK.

Steps for Sample Database Created with Sybase

1. From the Start menu, click Programs, IBM Cognos Series 7, IBM Cognos Impromptu Admin-

istrator.

If the Welcome dialog box appears, close it.

2. From the Catalog menu, click Databases.

The Database Definition Manager dialog box appears.

3. Expand ODBC, click GOS, and click Delete.

The logical database is deleted.

4. Click Sybase and click New Database.

The Database Definition dialog box appears.
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5. In the Logical database name box, type GOS

6. In the SQL Server name box, type the name of the server where the UNIX sample databases

are installed.

7. Click Test.

The Attach to Database dialog box appears.

8. In the User ID box and the Password box, type GOSales

9. Click OK.

10. In the Database Definition dialog box, click OK.

ObjectStore Error Using Impromptu Web Reports on UNIX
You received an error showing a cache manager initialization failure and/or file padding failure

that included a temporary ObjectStore location. The problem is that the drive on which your

ObjectStore temporary files are located does not have sufficient space available. There are two

environmental variables that default to the existing TMP variable value because they are not

specifically defined.

Solution

Define the two environmental variables and specify a drive location with adequate space for these

files.

1. To set the OS_ROOTDIR to point to the directory where you installed ObjectStore, type the

following:

OS_ROOTDIR=installation directory; export OS_ROOTDIR

where installation directory is the directory where ObjectStore is installed.

2. To add the ObjectStore executables location to the executable search path, type the following:

PATH=installation directory/bin:$PATH; export PATH

3. To add the two ObjectStore temporary directory locations, type the following commands on

your UNIX computer:

OS_CACHE_DIR=ObjectStore tmp directory location; export OS_CACHE_DIR

where ObjectStore tmp directory location is the directory for this temporary file.

OS_COMMSEG_DIR=ObjectStore tmp directory location; export OS_ COMMSEG_DIR

where ObjectStore tmp directory location is the directory for this temporary file.

4. Go to the directory where ObjectStore is installed.

5. Stop and then start the two ObjectStore services (osserver and oscmgr6) for the tmp file changes

to take effect.
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Database Create Error with Impromptu Web Reports
If you encounter a database creation failure error using Impromptu Web Reports, the problem

could be caused by an invalid database location property.

Solution

Check the properties in Configuration Manager for correct host computer name and location.

1. From the Start menu, click Programs, IBM Cognos Series 7, Tools, Configuration Manager.

2. Expand IBM Cognos Impromptu Web Reports.Common.Database.

3. Ensure the correct location on the database computer is specified in the Data Store Location
property value.

4. Ensure the Data Store Host property value specifies the correct database host computer name.

5. Expand IBMCognos ImpromptuWeb Reports, Data Store.Create Data Store.Copy Data Store

Schema Files.

6. Ensure the correct location on the server is specified in the Target Data Store Location property

value.

7. Expand IBMCognos ImpromptuWeb Reports.Data Store.Create Data Store.Create Data Store

Location.

8. Ensure the correct location on the server is specified in the Data Store Location property value.

9. Perform an apply and a start on the computer.

Database Not Created or Cannot Be Accessed Error with ImpromptuWeb Reports
If you encounter an error message stating that the database is not created or cannot be accessed

while you are using Impromptu Web Reports, the problem could be caused by one of the following:

● "Server Computer Database Properties Not Properly Defined to Know the Correct Host" (p. 84)

● "Database Computer Properties Properly Defined and ObjectStore Running but No Database

Created" (p. 85)

● "Host Computer is Available but the Database Location is Not Valid" (p. 85)

Server Computer Database Properties Not Properly Defined to Know the Correct Host

Solution

1. On the computer where Impromptu Web Reports is installed, start Configuration Manager.

2. Expand IBM Cognos Impromptu Web Reports.Common.Database.

3. Verify that the correct location on the server is specified in the Data Store Location property

value.

Example: D:\Program Files\Cognos\cern\iwr\database
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4. Verify the Data Store Host property value specifies the correct database host computer name.

Database Computer Properties Properly Defined and ObjectStore Running but No Database Created

Solution

1. Perform an apply and a start on the computer.

2. Follow the procedure to create a database on the database computer.

Host Computer is Available but the Database Location is Not Valid

Solution

1. On the database computer, create the directory in which the database files are to be saved.

2. Follow the procedure to create the database.

Cannot Run PowerPrompts Samples with UNIX Sample Database
If the sample databases are not set up with the recommended user name and password, the sample

PowerPrompts will fail.

This problem occurs because the samples catalog requires a catalog database signon before it runs

the PowerPrompts application that connects to the UNIX sample database.

Solution

Change the user name and password for each PowerPrompts sample.

1. From the Start menu, click Programs, IBM Cognos Series 7, Tools, and click PowerPrompts.

The PowerPrompts Developer Studio opens.

2. Open the PowerPrompts sample.

3. From the File menu, click Properties.

The Application Properties dialog box opens.

4. In the Application Properties dialog box, click the Catalog tab.

5. In the Catalog Database UserID box, type a valid username for the database.

6. In the Catalog Database Password box, type the password for the username.

7. Click OK.

PowerPrompts Samples Do Not Work with Sybase Sample Database
Sample PowerPrompts may fail when using a UNIX sample database that was created with Sybase.

This is because the SQL syntax for Sybase is different from the SQL syntax used to create the

dynamos and recordsets that the PowerPrompts samples use.

Installation Testing and Samples Setup Guide 85

Chapter 9: Troubleshooting



Solution

Modify the SQL statements in the dynamos and the recordsets so that they conform with the Sybase

SQL syntax.

Note: You must know the database owner value to perform the following procedure.

Steps to Modify the Dynamos to Conform to Sybase SQL Syntax

1. From the Start menu, click Programs, IBM Cognos Series 7, Tools, and click PowerPrompts.

The PowerPrompts Developer Studio opens.

2. Open the desired PowerPrompts sample.

3. Open Dynamo Manager.

4. Right-click on the desired dynamo and click SQL.

5. If the IBMCognos Common Logon dialog box appears, type the default user ID Administrator,

leave the password box blank, and click Log On.

6. In the SQL statement generated by the dynamo, delete the double quotation marks.

7. Add the database owner value to the SQL statement generated by the dynamo so it conforms

to the Sybase SQL syntax.

The following example shows the syntax for the sample dynamos as they are installed:

Dynamo.SQL='SELECT "database"."table_name"."column_name" FROM "data-

base"."table_name"

To conform to the Sybase SQL syntax, the previous example would change to the following:

Dynamo.SQL='SELECT database.owner.table name.column_name FROM data-

base.owner.table_name

8. Save the PowerPrompt and leave PowerPrompts Developer Studio open for the next procedure.

Steps to Modify the Recordsets to Conform to Sybase SQL Syntax

1. In PowerPrompts Developer Studio, right-click the page that failed and click Edit HTML.

2. Modify the SQL statements to conform to Sybase SQL syntax.

The following example shows the syntax for the sample recordsets as they are installed:

rs.variable_name.Open ("SELECT column_name FROM table_name", "database");

To conform to the Sybase SQL syntax, the previous example would change to the following:

rs.variable_name.Open ("SELECT database.owner.table_name.column_name FROM data-

base.owner.table_name", "database"

3. Save the HTML file.
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Upfront Icons Not Displaying Correctly
If you configured non-default Web aliases, ensure that all configuration properties are changed to

use the correct aliases. After you change configuration values, stop and start Upfront services, and

then start Upfront to verify that the icons display correctly.

For more information about configuring non-default Web aliases, see the Configuration Manager

User Guide.

Other Authentication Problems

Starting Upfront Server Administration Returns an Authentication or Access
Privileges Error

You receive an error message referring to the Upfront Administration server user not previously

authenticated or not having proper access privileges when starting Upfront Server Administration.

The problem is that a ticket service is not installed.

Solution

Install the Access Manager Server from the product installation CD and configure its ticket service.

Access Denied Message Trying to Connect to PowerPlay Enterprise Server After
Changing the LDAP Server/Namespace

You have changed the namespace for your directory server, but PowerPlay Enterprise Server is still

pointing to the old namespace or you still have the server secured to the old namespace.

Solution

1. Log in to PowerPlay Enterprise Server Administrator as a member of the old namespace.

2. Unsecure the server.

3. Change the namespace used as the authentication source to the new namespace.

4. Restart the PowerPlay Enterprise Server Administrator.

5. Use the menus to secure the server to the new namespace.

Repeated Requests to Log On
You have logged in and are using an IBM Cognos product, but have not finished working with the

information presented. You are presented with a Log In window and asked to log in (again). Your

session ticket has expired and your session can no longer continue using the product without you

logging in and validating yourself. You have exceeded the duration for a session that your admin-

istrator has defined for users. You can log in again and access your data again.

If you need to work with data for this length of time regularly, you can ask your administrator to

increase the duration of the ticket. There are issues dealing with security for providing longer session

times and your administrator can advise you whether a longer session time can be provided.
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Solution

1. Ask your administrator to increase the ticket duration value.

2. If your administrator agrees, they will use Configuration Manager to change theTicket Duration

property in Services.Access Manager - Server.General.Ticket Service.

3. You should be able to access and work with your information in one session without having

to log on multiple times.

If your administrator cannot increase the duration of the ticket, you will have to log on at the

expiration of each ticket. This could mean you need to log in and access your information multiple

times in a day to complete your task.

General Runtime or Installation Problems

File Transfer Fails in UNIX
The installation wizard copies installation files to the /tmp directory temporarily as part of the

installation process. If the directory is not large enough to accept all the files and fills up, the install

process appears to be running but is stalled while waiting for the current install file to be written.

Solution

Ensure the file system containing the /tmp directory provides sufficient space for the files to be

installed.

Access Manager Server Ticket Service Not Responding
If you are using Access Manager - Administration, you may receive a message that tells you that

the ticket service is not responding.

This problem can occur if the configuration values for the ticket service are incorrect, if the Access

Manager Server is not running, or if the Access Manager Server ticket service cannot be pinged.

Solution

1. From the Start menu, click Programs, IBM Cognos, Tools, Configuration Manager.

2. Expand Services.Access Manager - Server.General.Ticket Service.

3. Verify that the configuration values are correct and update them if necessary.

The default port for the ticket service is 9010.

4. Perform an apply and a start on Access Manager - Server.

5. After updating the configuration settings, use Access Manager - Administration to test the ticket

service.

Asian Fonts Do Not Display Correctly in PowerPlay
Asian fonts do not display correctly in PowerPlay if the fonts have not been installed on the server.
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Solution

Install Asian fonts on the PowerPlay Enterprise Server computer.

Fonts are not supplied with your IBM Cognos software. They are normally included with your

operating system.

PowerPlay Request Failures
You may experience PowerPlay request failures.

This problem could be caused by a diagnostic application running on the computer where PowerPlay

Enterprise Server is installed.

When a PowerPlay request process encounters difficulties, the PowerPlay dispatcher stops it and

starts a new process. Diagnostic applications such as Dr. Watson interfere with this activity and

can cause request failures.

Solution

Disable or remove all diagnostic applications running on the computer where PowerPlay Enterprise

Server is installed.

If you disable the diagnostic applications, use the Services tool in Control Panel to ensure that the

diagnostic application services are not set for automatic startup. Otherwise, the diagnostic applica-

tions will automatically start when the computer is rebooted.

Multiple Request Managers Running on Server
This problem can occur if the Database Share Name does not use the Universal Naming Convention

(UNC) to identify the shared name and the location where the database files will be stored.

Solution

1. On each Impromptu Web Reports computer, use Configuration Manager to change IBMCognos

Impromptu Web Reports.Common.Database.Data Store Host to specify the path, using the

following format:

servername.DNS.Identifier:drive:\path\iwr70.db

An example path for Windows is as follows:

IWRServer.Cognos.com:e:\Program_Files\Cognos\cern\database\iwr70.db

The following example shows a path for UNIX:

server/usr/cognos/cern/database/iwr70.db

2. Perform an apply and a start on the computer.

3. Run the report again.
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Apply Failure When Installing and Configuring Sun Java System Directory Server
from the IBM Cognos Install Menu

If you encountered an apply failure when installing and configuring the Sun Java System Directory

Server, you may have to check an additional file for details. If Configuration Manager reports an

error and cannot identify the reason for the failure, check the Sun Java System directory setup log

file, identify the problem, and correct it.

Check the installation error as identified in the setup log file and correct the problem.

Solution

1. Check the setup log file at directory_server_installation_location\setup\setup.log or in the system

temp directory.

2. Determine the cause of the installation failure from the log file.

3. Correct the identified problem and perform an apply to install the Sun Java System directory

server.

Runtime Parameters Not Saved in Environment Script File
If you change Runtime Parameter values and then export to an environment script file, the Runtime

Parameter values are not saved. If you are planning to use the script file for an unattended installa-

tion, no Runtime Parameters will be available and you will have to configure these manually after

the file has been used for the installation. The Runtime Parameters are regarded as being computer-

specific while the parameters exported to an environment script file apply to multiple computers.

Solution

1. Export your environment to a script file.

2. Perform an unattended installation.

3. Configure the Runtime Parameters with Configuration Manager.

4. Save the server configuration to a configuration specification file.

Sun Java System Directory Server Availability Problems
The PowerPlay Enterprise Server Administration is detecting changing status for the Sun Java System

directory server and displaying this alternating status. The Sun Java System directory server is

encountering a log file space exhaustion problem. It cannot complete the write operation in a timely

manner and its availability status keeps changing. This problem is known to Sun Java System and

they are working to resolve it.

Solution

Disable logging of events in Sun Java System directory server.
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Display Problems When Using AIX with Exceed
You are experiencing window or menu positioning problems on your screen using Exceed 7.0 on

your AIX system when running PowerPlay Enterprise Server Administration. The problem originates

from the default X Window system and Exceed's inability to work successfully with Java 1.3 to

properly display windows and menus. It is recommended that you use another X Window manager

until the problem is resolved. Motif Window Manager for X has been tested and functions properly.

Other X Window Manager programs are available, but not all have been tested. The Motif Window

Manager for X is available on every AIX system. The different manager program affects the decor-

ations and overall look of the Exceed xterm window, but will not affect the look and feel of the

PowerPlay Enterprise Server Administration.

Solution

1. Open an xterm window using Exceed.

2. Type mwm & to start mwm running in the background.

3. Go to the installation_location/bin folder, and launch PowerPlay Enterprise Server

Administration using ppsrvadm.sh.

Cannot Execute Commands in the Documentation or Commands Are NotWorking
as Expected (UNIX)

You are using the wrong shell. We officially support the Bourne (standard or sh) shell and document

this functionality. You may have changed to another shell such as the C shell (csh) or the Korn shell

(ksh). Changing back to the Bourne shell will make commands in the documentation function

normally again.

Solution

At the command line, type sh

Error Message When Configuring Microsoft Active Directory
You are unable to apply the configuration settings on a Windows computer to remotely configure

a Microsoft Active Directory. This problem occurs because a program is missing on the Configuration

Manager computer to enable it to remotely configure the Microsoft Active Directory. An ADSI

Runtime patch must be installed from the IBM Cognos CD.

Solution

1. Open the folder \3rdparty\Microsoft\ADSI on the IBM Cognos CD.

2. Proceed configuring the remote Active Directory.

Menu Shortcuts (Alt+key) Do Not Work in Administration Program (UNIX)
Your keyboard input definitions are set incorrectly.
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Solution

1. Start Exceed/Xconfig.

2. Open the KeyboardInput dialog box.

3. Find the Alt Key: combo box in the Window Modifier Behavior group.

4. Click the To X option.

Problem Identifying the Namespace When Logging into Upfront
You need to add an identifier to your namespace. You can define an identifier for your namespace

using Access Manager Administration. The identifier will appear on the Upfront logon screen to

help you identify the namespace.

Solution

1. From the Startmenu, click Programs, IBMCognos Series 7, IBMCognos Server Administration.

2. Click Security.

3. Expand the entries under Directory Servers.

4. Click the namespace.

5. Open Properties.

6. Click the Summary tab.

7. In the Title field, type an identifier for the namespace and click OK.

Cannot Establish Connection to NoticeCast Data Store
If you encounter an error in NoticeCast when performing a default apply, a problem with connecting

to the data store has occurred. The problem could be caused by one of the following:

● Data Store User ID or Password is Incorrect

● Database URL is Incorrect for Your Database

● Database Computer Not Running or Network Not Available

● Database Not Set Up to Contain the NoticeCast Data Store

Data Store User ID or Password is Incorrect

The user ID and password used to access the database data store are not recognized.

Solution

1. Verify the user logon ID and password for accessing the data store with your database admin-

istrator.

2. From the Start menu, click Programs, IBM Cognos Series 7 Version 4, Tools, Configuration

Manager.
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3. Go to Cognos NoticeCast.NoticeCast Data Store.database Data Store Configuration.

4. Change the user ID in the Data Store Logon ID property.

5. Change the user logon password in the Data Store Logon Password property.

Database URL is Incorrect for the Database

If the database computer is running and network connections are working, the URL specified in

the Database URL property in Cognos NoticeCast.NoticeCast Data Store.database Data Store

Configuration is not correct.

Solution

1. Verify the URL with your database administrator.

2. From the Start menu, click Programs, IBM Cognos Series 7 Version 4, Tools, Configuration

Manager.

3. Expand Cognos NoticeCast.NoticeCast Data Store.database Data Store Configuration.

4. Change the URL for the database in the Database URL property.

Database Computer Not Running or Network Not Available

If the computer on which the database is located is not running or if you have a network problem,

NoticeCast server cannot establish a connection.

Solution

1. Ping the server using the database computer name.

2. If the database computer is responding, ensure the required services are running on it.

3. If the database computer is not responding, ping it using the IP address for the computer.

4. If the database computer is not responding, resolve the network connectivity issue then retest

the connection.

5. If the database computer is responding using the IP address but not the database computer

name, your network does not recognize the relationship between the database computer and

the IP address. Resolve this problem with your network administrator and test the connection.

Database Not Set Up to Contain the NoticeCast Data Store

The NoticeCast data store must be defined within the database for NoticeCast server to be able to

connect to the data store.

Solution

● Ensure the database has been set up to contain the NoticeCast data store.
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JDBC Driver Not Included in Class Path After Default Configuration
Applyingthe NoticeCast configuration properties results in an error that the defined JDBC driver

is not included in the class path. NoticeCast uses Java Database Connectivity (JDBC) to connect

to the data store. If your NoticeCast data store is within an SQL server database, you have a suitable

driver installed already. If your data store is within Oracle, Informix, or DB2, you must locate the

driver in your installation directories and ensure that this location is specified in Configuration

Manager properties.

Note that Java is case-sensitive.

Solution

1. In Configuration Manager, expand Cognos NoticeCast.NoticeCast Data Store.General.

2. Verify that the Data Store Connection File property is set to the correct database type.

3. Expand Cognos NoticeCast.NoticeCast Data Store.database Data Store Configuration, where

database indicates the type of database in use.

4. Verify that the JDBC Driver File property is set to the correct location and filename of your

JDBC driver. The path and filename are case-sensitive in UNIX.

Alerts Button on PowerPlay Web Toolbar is Disabled
The alert functionality has been disabled within PowerPlay Enterprise - Server Administration.

Solution

1. From the Startmenu, click Programs, IBMCognos Series 7, IBMCognos Server Administration.

2. Click OLAP Cubes and Reports.

3. Connect to the PowerPlay Server.

4. From the Edit menu, click Properties.

5. Click the Settings tab.

6. Click Enabled for the PowerPlay Web Explorer Alerts property value.

7. Click OK.

8. Close PowerPlay Enterprise - Server Administration.

9. From the Start menu, click Programs, IBM Cognos Series 7, Tools, Configuration Manager.

10. Stop and start IBM Cognos PowerPlay Enterprise Server.

UNIX File Transfer May Not Function Properly
On some UNIX terminals or terminal types, if you run the UNIX file transfer (named the installation

wizard) in character UI mode, the screens appear jumbled or some or all of the function keys do

not work. To avoid this problem, you can copy the files using an unattended transfer.
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To do unattended transfer, you must edit the response.ats file and run the command xwsetup.exe

-s Response.ats

Note: You can designate a full path for the response file so that it can be located in a writable loc-

ation for editing.

Each section in the response.ats file corresponds to a dialog box in the installation program.

Steps to Edit the Response.ats File

1. Open the Response.ats file using a text editor.

The file is located in the Cognos/product name directory in the installation location. Copy it

to a writable location for editing.

2. Edit the installation location by editing the APPDIR= entry.

For example: APPDIR=/usr/cognos/cern

3. Edit the components to install by editing the "Component List" section.

Entering 0 for a component does not install the component.

Entering 1 for a component will install the component.

4. When you are finished editing the file, save it.

5. Go to the Cognos/product name directory.

6. Type the following command:

xwsetup.exe -s location/Response.ats

where location is the path where you saved the response.ats file.

Display Problems When Using HPTerm on UNIX
If you see unexpected color combinations or buttons are not clearly visible when you invoke xwsetup

using hpterm, it is probably because hpterm does not support VT220 terminal emulation. The

installation system requirements state any terminal emulator used should support VT220 emulation

or hot keys in the installation might not work. The hpterm emulator does not support VT220

emulation. HP recommends using dtterm if you require VT220 support.

Solution

Install dtterm and ensure the emulation is set to VT220.

Configuration Manager Cannot Write Properties to Registry in Windows 2000
You receive an error showing Configuration Manager cannot write to the registry when you perform

an apply on your Windows 2000 computer. The program is unable to write to

HKEY_LOCAL_MACHINE or HKEY_CLASSES_ROOT. The problem is that you do not have

administrator privileges, which permit you to write properties.
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Solution

Change your user privileges to allow Configuration Manager to write to the system registry.

1. Using the Services tool in Control Panel, double-click the Users & Passwords icon.

2. If you have administrator privileges, the Users & Passwords window appears. Click the Users

tab if you wish to view your user ID in the Members box.

If you do not have administrator privileges, you cannot open Users & Passwords and will

receive a message telling you that you are not a member of the Administrator group. Ask your

system administrator to add you to the Administrator group.

Failure Transferring or Installing a File in UNIX
If you received a copy failure message when transferring or installing a file in UNIX, your parent

directory may not have adequate space to insert the file.

Solution

1. Check the available space in the parent directory.

2. Check the size of the file being copied.

3. If the file is larger than the available space, make more space available in the destination.

If you cannot make more space available, install your files on another disk drive.

Unable to Run the Setup Program issetup on UNIX Installation - Permission
Denied

After performing an FTP transfer of installation files from Windows or UNIX instead of installing

from the CD, you cannot execute the xwsetup program. The problem is that the permissions have

been changed and you must change them to allow you to execute the program.

Solution

1. Go to the directory where the xwsetup file is located.

2. Change the permissions on this file to give it execute permissions by typing chmod +x issetup

3. Type ./issetup to start the installation wizard.

ObjectStore Server is Unavailable or Not Configured Properly
If you receive an error message while creating a database or while using Configuration Manager

to apply values, the problem could be caused by one of the following:

● "ObjectStore is Not Installed" (p. 97)

● "ObjectStore Services or Database Computer Operating System Not Started" (p. 97)

● "Impromptu Web Server Computer Cannot Access the Database Host Machine" (p. 97)
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ObjectStore is Not Installed

Ensure the correct version of ObjectStore has been installed successfully on the database machine.

See the installation guide for information about installing ObjectStore.

ObjectStore Services or Database Computer Operating System Not Started

Ensure the operating system and the two ObjectStore services have been started before you try to

create a database or perform an apply and a start on the Impromptu Web Reports computer. If

they have not been started, start them.

1. If the operating system is not running, start the machine as usual.

2. Verify that the two ObjectStore services are running. If they are not running, start them.

● In Windows, open Control Panel, Services and verify that ObjectStore Cache Manager

R6.0 and ObjectStore Server R6.0 have started and that startup is set to automatic.

● On UNIX, type ps -ef | more to display the status of processes. Start osserver and oscmgr6

as required.

Impromptu Web Server Computer Cannot Access the Database Host Machine

You may be experiencing network problems, the configuration properties for your database com-

ponents may be incorrect, or the configuration properties are correct but have not been applied.

Solution

1. If your database resides on another computer, from your Impromptu Web Reports computer,

ping the database computer using the server name.

If the ping is successful, proceed to step 3.

2. From the Impromptu Web Reports computer, ping the database computer using the IP address.

If this ping is successful and the ping by server name was unsuccessful, there is a problem con-

necting by server name. If the server name that you pinged in step 1 exists and is running, the

Domain Name System (DNS) may be unable to translate the server name to the correct IP

address. To resolve this, you may need to edit the host file.

3. Using Configuration Manager, expand IBM Cognos Impromptu Web Reports.Common.

Database.

4. Ensure the correct location on the database computer is specified in the Data Store Location
property value.

5. Ensure the Data Store Host property value specifies the correct database host computer name.

6. Perform an apply and a start on the server.
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Errors Using the DataDirect ODBC Driver Manager on UNIX with Locale Other
Than en_US

A default installation of DataDirect ODBC Driver Manager on UNIX assumes that the LANG

environment value is en_US. If your locale is not set to en_US, then the driver may not connect to

the database. You may recieve an error message such as,

The driver returned invalid (or failed to return) SQL_DRIVER_ODBC_VER:

or

[DataDirect][ODBC lib] Driver does not support this function

The same error can occur if the process sets the locale by calling setlocale with an explicitly defined

value, and that value is not en_US.

Solution

To correct the error, create a symbolic link in the installation_location/locale directory that has the

same value as the LANG environment setting. This link must point to the installation_loca-

tion/locale/en_US directory. For IBM Cognos products, this link should use the same value as the

Cognos Shared.Locale.Native Locale property in Configuration Manager.

For more information, see the ODBCREAD.ME document, located in the driver installation directory.

Characters Do Not Display Correctly in Email on Mobile Devices
Mobile devices, such as PDAs and mobile phones, do not support all character sets. For example,

some mobile devices support only the Shift-JIS charater set. When users view alerts or notifications

on a mobile device, some characters may not display correctly due to a encoding conflict between

the mobile device and the IBM Cognos NoticeCast installation. The most typical problem is char-

acters that appear as question marks (?).

Solution

To correct character display problems, you can change the default encoding used for email generated

by the IBM Cognos NoticeCast server. The default encoding for outgoing email is UTF-8.

1. On the computer where the IBM Cognos NoticeCast server is installed, start Configuration

Manager.

2. Select Cognos NoticeCast.NoticeCast Server.Mail Server.

3. Change the SMTP Mail Content Encoding property to a supported character set.

4. Right-click NoticeCast Server and click Apply Selection.

For more information about IBM Cognos NoticeCast configuration, see the Configuration Manager

User Guide. For more information about supported character sets, see the IBM Cognos Software

Services Web site.
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Cannot Configure the Directory Server for Series 7 Via a Secured Port
You cannot configure the directory server for Series 7 via a secured port. You must first configure

the directory server for Series 7 via a standard unsecured port and then secure the connection using

SSL.
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